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Chapter 1. Introducing IBM Director on 
System p5

This chapter provides an overview of the IBM Director for managing 
IBM System p5™ servers. It helps you to understand the specifics of 
IBM Director on System p5 platform, and to decide if IBM Director is the best way 
to manage your environment. 

We start by reviewing some general concepts about IBM Director. Then we 
provide a list of features available for IBM Director on System p5 platform, 
including extensions. Finally, IBM Director is compared to other system 
management products, providing you with the necessary knowledge to make the 
right choice for managing your environment.

1
 

 

 

 

© Copyright IBM Corp. 2007. All rights reserved. 1



1.1  Overview

IBM Director is an integrated suite of tools that provides you with comprehensive 
system management solution for heterogeneous environments, including 
IBM System p5 environment. 

This paper focuses on System p5 management using IBM Director 5.20 on 
System p5 platform.

IBM Director automates numerous processes that are required to manage your 
infrastructure proactively, including software distribution, system inventory, 
monitoring, remote hardware control, task execution, and more.

The IBM Director core infrastructure is designed to provide a single point of 
control for managing up to 5,000 agents. It has a graphical user interface that 
provides easy access to both local and remote systems.

For more information about IBM Director, details on managing other platforms, 
and for licensing information, visit the following Web pages:

� IBM Director home page

http://www-03.ibm.com/servers/eserver/xseries/systems_management/ibm
_director/

� Implementing IBM Director 5.20, SG24-6188

1.2  IBM Director environment

IBM Director is designed to manage complex environments that contain a large 
number of servers. Focusing on System p5 management, an IBM Director 
environment contains the following groups of hardware:

� Management servers: One or more servers on which IBM Director is installed. 
See 2.1, “Planning” on page 20, for supported operating systems and 
System p servers.

� Managed systems: Logical partitions (LPARs) and servers that are managed 
by IBM Director. It includes System p and System p5 servers and IBM 
BladeCenter® JS20.

� SNMP devices: Devices that have Simple Network Management Protocol 
(SNMP) installed. 
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� Managed objects: Any additional managed object, such as platforms, 
chassis, and Hardware Management Console (HMC).

Figure 1-1 shows a sample environment (hardware) that can be managed using 
IBM Director.

Figure 1-1   IBM Director environment

1.3  IBM Director components

The IBM Director product consists of four components: 

� IBM Director Core Services: Systems that have IBM Director Core Services 
(but not IBM Director Agent) installed on them are referred to as Level-1. 
Level-1 control provides hardware-specific functionality for IBM Director to 
communicate with and administer the managed system.

Note: Note that AIX has an SNMP server installed and running by default. 
See Appendix A, “Configuring SNMPv3 for AIX and Linux for POWER” on 
page 87.

Management console
IBM Director Console 
installed

Management server
IBM Director Server installed,
which installs:

IBM Director Agent
IBM Director Console

TCP/IP Various protocols

Others SNMP Devices

SNMP Agent

SNMP Devices

Level 0 managed systems
no IBM Director 
components installed

Level 1 managed systems
IBM Director Core Services 
installed on each 

Level 2 managed systems
IBM Director Agent 
installed on each 

Managed Systems
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� IBM Director Agent: Systems that have IBM Director Agent installed on them 
are referred to as Level-2 managed systems. Level-2 provides enhanced 
functionality with which IBM Director can communicate with and administer 
the managed system.

� IBM Director Console: This is the graphical user interface (GUI) for 
IBM Director Server from which the system administrator can perform tasks in 
IBM Director. This is automatically installed with the Director Server on 
System p, running AIX or Linux. The IBM Director console provides the same 
GUI, independently of the machine type and operating system (OS).

� IBM Director Server: This is the main component of IBM Director. It contains 
the management repository and data, the server engine and the application 
logic. It provides all the management functions of IBM Director.

IBM Director can also manage systems on which no component of IBM Director 
is installed. Such managed systems are referred to as Level-0 managed 
systems. These systems must at a minimum support either the Secure Shell 
(SSH) or Distributed Component Object Model (DCOM) protocol.

IBM Director capabilities relative to the different levels are detailed in 1.4, “IBM 
Director capabilities on System p5”. The management features vary according to 
the operating system on which the agent is installed.

1.4  IBM Director capabilities on System p5

IBM Director provides a comprehensive suite of system management 
capabilities. Management capabilities can vary depending on the operating 
system hosting the management server, the operating system of the managed 
system, and the agent level installed on it.

This section provides a list of the tasks available for a System p5 management 
server and the features available from a managed System p5 server.

Important: IBM Director Core Services (known as agent Level-1) are not 
supported on AIX.
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1.4.1  IBM Director Server tasks

When running in a System p5 server, almost all of the IBM Director Server tasks 
are available. The following list includes both core features and extensions:

� Base Director tasks available on System p5 server: Discovery, Associations, 
Group Management, System Status, Inventory, Event Log Viewer, Event 
Action Plan, Resource Monitor, Process Management, Remote Control, 
Remote Session, File Transfer, CIM Browser, SNMP Browser, Scheduler, 
Update Assistant, Microsoft® Cluster Browser, Discovery preferences, 
Console preferences, Server preferences, User administration, Encryption 
administration, Message Browser, Command Line Interface

� Platform tasks available on System p5 server: Hardware/System status, 
Hardware Control, Asset ID™, Configure SNMP Agent, Network 
Configuration, System Accounts

� BladeCenter tasks available on System p5 server: BladeCenter 
Configuration Wizard, BladeCenter Management Module Launch, Switch 
Management Launch

� IBM System x™ specific functions

– Available on System p platform: Management Processor Assistant 
Launch, Configure Alert Standard Format

– Not Available on System p platform: ServeRaid Manager

� Other platform-specific tasks available on System p platform: HMC 
Support, z/VM® Center Management

� Advanced Server tasks 

– Available on System p platform: Rack Manager, Software Distribution

– Not available on System p platform: Capacity Manager, System 
Availability, Remote Deployment Manager, Virtual Machine Manager

Note: IBM Director management server tasks that are available are the same 
whether they are running on AIX or Linux on POWER.

Attention: Some tasks are available on a Windows® management server 
used as System p5 management, but are not available in a System p5 
management server, regardless of the managed operating system.
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1.4.2  IBM Director Agent features

Depending on the agent level, a System p managed system provides different 
features for management.

See 2.1, “Planning” on page 20, for details about the OS supported by the 
IBM Director Agent.

Agentless managed systems
A managed System p5 server on which no IBM Director component is installed is 
named as an agentless system, or Level-0.

An agentless managed system provides the following basic features:

� Discovery
� Remote session (requires ssh)
� Power control
� Promotion to Level-1 or Level-2 through Update Assistant

For more details on enhancing Level-0 features with SNMP, see 3.3, “Working 
with agentless (including SNMP) systems” on page 63.

For more details on the software distribution task, see 3.4, “Using Software 
Distribution” on page 72.

Agent Level-1 managed system
Managed systems that have IBM Director Core Services (but not IBM Director 
Agent) installed on them are referred to as Level-1. It provides hardware-specific 
functionality for IBM Director to communicate with and administer the managed 
system.

The IBM Director Core Services package installs on Linux: 

� A Service Location Protocol (SLP) service agent
� An Secure Sockets Layer (SSL) enabled CIMOM
� An optional ssh server
� Platform-specific instrumentation

Restriction: These systems must at a minimum support either the Secure 
Shell (SSH) or Distributed Component Object Model (DCOM) protocol.
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IBM Director Core Services provide a subset of IBM Director Agent functionality. 
Level-1 Agent provides management entirely through standard protocols. You 
can perform the following tasks on a Level-1 managed system:

� All Level-0 functions

� Collecting inventory

� Promotion to Level-2 management by distributing the IBM Director Agent 
package

� Managing events using event action plans, event subscription, and the event 
log

� Monitoring hardware status

� Running command-line programs

� Distributing system update packages through Software Distribution

Agent Level-2 managed system
A managed system on which the IBM Director Agent is installed is referred to as 
Agent Level-2 managed system. It provides enhanced management 
functionalities, which vary depending on the operating system on which it is 
installed.

Table 1-1 describes the IBM Director Agent functions supported on AIX 5L and 
Linux on POWER systems.

Table 1-1   IBM Director capabilities on System p5 platform 

AIX Linux

Base IBM Director function

Inventory hardware Yes Yes

Inventory operating system/software Yes Yes

Resource Monitor Yes Yes

Process Management Yes Yes

Remote control No No

Remote session Yes Yes

File Transfer Yes Yes

CIM Browser Yes Yes

Update Assistant Yes Yes

Microsoft Cluster Browser No No
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“Yes” indicates that at least limited functionality of the feature is available.

From this list, we have selected some of the useful features for System p5 
management. See Chapter 3, “Scenarios” on page 41, for more details about 
objectives and implementation.

Figure 1-2 shows the proposed actions when you right-click a System p5 
managed system running the IBM Director Agent.

Platform-specific tasks

Hardware/System status No Yes

Asset ID No Yes

Configure SNMP Agent Yes Yes

Network Configuration No No

System Account No No

Capacity Manager No No

System Availability No No

Software Distribution Yes Yes

Note: IBM Director 5.20 for System p brings the following improvements:

� Supports the micropartition resource monitoring, dedicated or shared 
processor, capped or uncapped mode

� Common Information Model (CIM) currency

� Hardware status improvements on AIX
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Figure 1-2   Right-clicking a Level-2 System p5 managed system

1.4.3  IBM Director extensions for System p5

In this section, we present the IBM Director extensions, free or fee-based, and, 
for each of them, we focus on the System p5 management.

IBM Director extensions are plug-in modules, which extend the capabilities of 
IBM Director:

� Install-time extensions: Provided on the base IBM Director CD, installed along 
with IBM Director Server

� Free extensions: Available for download at no charge

� Fee-based extensions: Products that require a license

Install-time extensions
Depending on the platform on which you install IBM Director Server, the 
installation package comes with different install-time extensions, which are 
automatically installed with the server software.
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When installing IBM Director Server on System p (AIX 5L or Linux), the 
installation package contains:

� Cluster Systems Management (CSM) hardware control utils
� Flexible Service Provider
� Collection Services extensions
� IBM Director Agent
� ASMLIB
� System x extension
� BladeCenter extension
� IBM Director HMC common code extension
� IBM Director HMC console extension

See section 3.1, “Hardware Management Console managed environment” on 
page 42, for details on how to work with HMC managed systems.

Additional extensions
In addition to the basic IBM Director server installation, some extensions can 
extend its capabilities.

For more information about how to download or buy IBM Director extensions, 
visit the IBM Web site at:

http://www-03.ibm.com/servers/eserver/xseries/systems_management/ibm_di
rector/extensions/sysa.html

This section list the extensions available on a System p management server. 
See Table 1-2 for the complete list.

Table 1-2   IBM Director on System p extensions

Note: Certain IBM Director extensions are not supported on a System p 
management server. However, they can be installed on a Windows 
management server that is used to manage a System p5 server.

Extension type Availability on System p

HMC Install-time Yes

BladeCenter Install-time Yes

System x Install-time Yes

ServeRAID™ Free No

System Availability Free No

Virtual Machine Manager Free No

 

 

 

 

10 IBM Director on System p5

http://www-03.ibm.com/servers/eserver/xseries/systems_management/ibm_director/extensions/sysa.html


For more information about these IBM Director extensions, refer to the manual 
IBM Director Systems Management Guide (Appendix I):

http://publib.boulder.ibm.com/infocenter/eserver/v1r2/topic/diricinfo_5
.20/fqr0_bk_systm_mgmt.pdf

1.5  IBM Director positioning

IBM has several robust system-management offerings available that give the 
customer the choice regarding the way they want to manage their System p5 
infrastructure. IBM Director is one of the choices, along with IBM Cluster 
Systems Management and Tivoli systems management suite of tools.

Capacity Fee-based No

Software Distribution 
Premium Edition

Fee-based Yes

Remote Deployment 
Manager (RDM)

Fee-based No

z/VM Fee-based Yes

Note: Install-time extensions are free, as they come with the IBM Director 
code.

Note: Virtual Machine Manager Extension cannot be installed along with 
IBM Director management server on System p. However, when this feature is 
installed on another platform, this extension provides useful features for 
LPARs running on System p.

Extension type Availability on System p 
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Figure 1-3 shows IBM systems management products.

Figure 1-3   IBM systems management products

1.5.1  IBM Director versus Cluster Systems Management

IBM Cluster Systems Management (CSM) offers a way to manage a collection of 
AIX 5L, Linux, or a combination of servers (nodes) from a single point of control.

CSM functions include automated setup, hardware control, monitoring, and 
configuration file management. Administrators can manage individual nodes, run 
commands across nodes or groups of nodes, monitor system resources, and run 
automated responses to events.

Cluster Systems Management
IBM Unix Systems Management Product

for xSeries and pSeries 

IBM Director Multiplatform
General Systems Management for IBM eServer  

machines

Shared Hardware Control Components
Common Command Line Interface

Event Integration

Virtualization Engine 
Console provides
GUI integration

IBM Tivoli

Enterprise Systems Management
IBM and non-IBM hardware

Upward Integration Module 
SNMP

Note: IBM CSM is based on IBM Reliable Scalable Clustering Technology 
(RSCT) infrastructure, which is supported and works the same way on both 
AIX and Linux (on IBM platform).
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For more information about CSM, visit the CSM documentation Web page:

http://publib.boulder.ibm.com/infocenter/clresctr/vxrx/index.jsp?topic=
/com.ibm.cluster.csm.doc/clusterbooks.html

So far, it looks like IBM Director and CSM have a lot of common features. 
However, they also have distinct value points. The objective of this section is to 
clarify the differences between the two IBM system management offerings, and 
help you to choose the most efficient way to manage your System p5 
environment.

Simply stated, IBM Director provides general purpose GUI management, while 
CSM is more specialized for IBM systems running AIX5L and Linux.

Table 1-3 provides a high-level comparison between the two products.

Table 1-3   High-level comparison between IBM Director and CSM

Functional comparison
IBM Director and CSM have overlapping features. This section intends to provide 
you a recommendation for each of them.

Hardware configuration
IBM Director provides Management Processor Assistant (MPA)/Configuration 
Wizard to help set up management modules, and monitor state changes and 
security settings.

CSM involves more manual steps for setting up hardware configuration and 
management.

IBM Director IBM Cluster Systems Management

General purpose management in distributed 
environments

Specifically designed for parallel scalability 
and execution in high-performance cluster 
environments

Management primarily by drag-and-drop GUI; 
command-line interface (CLI) limited.

Comprehensive, fully scriptable CLI. Some 
management via WebSM GUI.

Higher-level management functions such as HW/SW 
inventory

Limited higher-level functions; no specific 
inventory functionality

Supports AIX 5L, Linux, i5/OS®, and Windows on IBM 
and non-IBM systems

Supports AIX 5L and Linux on System p, 
System x and System i LPARs running AIX or 
Linux (limited HW control).

Virtualization and Image Manager extensions (fee based) 
allow NIM mksysb AIX deployment for System p; 
Software Distribution now available on System p

Full deployment of AIX 5L or Linux.

 

 

 

 

 Chapter 1. Introducing IBM Director on System p5 13

http://publib.boulder.ibm.com/infocenter/clresctr/vxrx/index.jsp?topic=/com.ibm.cluster.csm.doc/clusterbooks.html


Installing and updating software
IBM Director provides:

� Software Distribution Premium Edition, or SDPE, (fee-based extension) now 
supports package deployment on System p

� Remote Deployment Manager, or RDM, (fee-based extension) does not 
support AIX or Linux on POWER

� Initiation NIM installs via Event Action Plans, to be set up manually

CSM supports the installation and updating of software on AIX and Linux on 
POWER.

Inventory
IBM Director provides Hardware and Software Inventory and Asset Management 
functionality.

CSM’s dsh, SMS, and remote firmware commands can be used for some 
hardware and software inventory.

Troubleshooting and diagnostics
IBM Director has hardware status that indicates when a component goes bad.

CSM provides power status, hardware status and information, and diagnostic 
probes (extensible).

Event monitoring
IBM Director provides OS and hardware monitoring, and actions can be run in 
response to events.

Recommendation: Director has more automatic functions and requires less 
manual intervention.

Recommendation: Both products can be used for updating of software. 
However, CSM should be used for network installations.

Recommendation: Director has more robust and convenient functions.

Recommendation: Both products have good capabilities, with the 
specification that CSM allows easier development of new probes.
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CSM provides OS and hardware monitoring, and actions can be run in response 
to events.

When to recommend one solution versus the other
This section presents a comparison of the general characteristics of the two 
products, IBM Director and CSM. It is intended to help you to make your choice 
not only based on the features, but also on the characters of the products.

Table 1-4   When to choose IBM Director or CSM

Licensing
Your choice between these two powerful products can be determined based 
upon the implementation cost. Here, IBM Director and CSM are totally different.

Like almost all the IBM systems, when you buy a System p, it includes a license 
for IBM Director Agent. However, support is not included. In addition, you can 
also purchase additional licenses for non-IBM systems. 

CSM is priced for value. Even though a trial version can be used for 60 days, you 
have to purchase a license for the server and every node managed by CSM 
thereafter. 

IBM Director integration with CSM
In some cases, your System p5 management requires both IBM Director and 
CSM’s distinct features. The two products can coexist.

Recommendation: Both products provide this function. A wider range of 
hardware platforms and devices is available in IBM Director. CSM provides 
more details when monitoring System p and certain System x hardware.

Choose IBM Director if you want: Choose CSM if you want:

� A Windows style GUI for systems management 
tasks

� To manage multiple IBM HW and OS platforms 
with the same management tool

� To manage a wide variety and mixture of types 
of machines in your management domain

� Higher level management functions such as 
complete hardware/software inventory

� More complete IBM eServer xSeries® (PCI, 
ServeRAID, and so on), and BladeCenter 
configuration support

� Support for non-IBM hardware and also 
IBM hardware

� A full command line and scripting ability for 
system administration tasks

� To use just parts of the system management 
tool and fit them into your existing 
management processes

� Scalable, parallel operations across a fairly 
homogeneous set of machines

� High Performance Computing (HPC) 
environments, (especially Cluster 1350™, 
Cluster 1600, or HPS switch customers)

� Integrated deployment for AIX and Linux
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Today, CSM and IBM Director can coexist with the following limitation: Remote 
Deployment Manager (RDM) and CSM (NIM) cannot coexist on the same 
subnet, because there will be Dynamic Host Configuration Protocol (DHCP) and 
Preboot eXecution Environment (PXE) conflicts. If both RDM and CSM are set 
up to perform system software installations, then each server has to be on a local 
subnet to the respective nodes.

Conclusion
The two products have distinct value points and overlapping capabilities.

CSM should be considered when the target managed systems are UNIX and 
High Performance Computing (HPC) environments. CSM is the distributed 
systems management tool of choice for System p and System p clusters.

IBM Director should be viewed as a general system management tool that 
supports a variety of platforms.

1.5.2  IBM Director and Tivoli positioning

The systems management arena can be defined based on three IT 
organizational levels:

� Element management

Element managers provide a level of information detail and management 
functionality specific to the platforms they manage (for example, Intel®-based 
PCs), which is unavailable with higher level management platforms.

� LAN suites or workgroup management

Workgroup managers provide most of the functionality of element managers, 
but they usually add more software management features, such as software 
distribution.

� Enterprise management

Enterprise managers provide the integration and centralized management 
that is required in large IT infrastructures.

IBM Director provides a high level of integration with many key workgroup and 
enterprise managers, providing a robust solution.

Compatibility is achieved by exploiting the implementation in the IBM Director 
Agent of the latest systems management standards, including Common 
Information Model (CIM), Web-Based Enterprise Management (WEBM) and 
Extensible Markup Language (XML). 
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Features
IBM Director is required for low-level functions; as the functional requirements 
grow and managing applications becomes a priority, Tivoli is the answer. 
Therefore, there is a good cooperation between Tivoli management software and 
IBM Director.

Figure 1-4 shows the cooperation between IBM Director and IBM Tivoli from the 
resources point of view.

Figure 1-4   IBM Director and Tivoli

IBM Director
IBM Director covers:

� “Care and feeding” of the hardware
� Detailed hardware inventory, alerts and tools for IBM systems
� Basic software distribution
� Upward integration into the Tivoli environment
� Advanced, predictive server hardware management

IBM Tivoli 
IBM Tivoli covers:

� Highly scalable cross-platform enterprise level systems management solutions
� Sophisticated systems management and monitoring capability
� Advanced software distribution 
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� Applications management 
� Network management
� Business systems management 

Integration
IBM Director has the ability to integrate with enterprise management solutions 
from a number of vendors. Unlike other hardware vendors, whose systems 
management software can only integrate with the same brand of enterprise 
software, IBM Director enables you to get the most out of your enterprise 
management structure. It upwardly integrates with:

� IBM Tivoli Management Framework
� IBM Tivoli NetView
� HP OpenView
� Microsoft Systems Management Server (SMS)
� Microsoft Operations Manager (MOM)
� CA Unicenter
� BMC Patrol

With the upward integration modules (UIMs), you can use your systems 
management software to manage systems installed with IBM Director Core 
Services or IBM Director Agent software. You can use IBM Director Agent 
software to: 

� Gather detailed inventory information about your systems, including operating 
system, memory, network adapters, and hardware

� Track your systems with features such as power management, event log, and 
system monitor capabilities

For detailed information about IBM Director UIMs for Tivoli, refer to the manual 
IBM Director 5.20 Planning, Installation, and Configuration Guide:

http://publib.boulder.ibm.com/infocenter/eserver/v1r2/topic/diricinfo_5
.20/fqp0_bk_install_gde.pdf

Note: Tivoli and IBM Director together deliver the most comprehensive 
end-to-end systems management in the industry.
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Chapter 2. Installation examples

This chapter contains information that helps you with the planning and installing 
of your management environment using the IBM Director suite (Server, Agents, 
Console).

In this chapter, the following topics are discussed:

� Planning

� Installation on AIX 5L

� Installation on Linux on POWER

2
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2.1  Planning

Before installing IBM Director 5.20, we recommend that you review the 
installation requirements and plan your installation. See the manual IBM Director 
5.20 Planning, Installation, and Configuration Guide at:

http://publib.boulder.ibm.com/infocenter/eserver/v1r2/topic/diricinfo_5
.20/fqp0_bk_install_gde.pdf

2.1.1  Minimum requirements

This section presents the minimum requirements for installing and running 
IBM Director Server, Agent, or both.

Minimum hardware requirements
We recommend that you consider the following information when you review the 
hardware requirements for both AIX 5L and Linux on POWER.

� The disk space specified in Table 2-1 on page 21 is the minimum requirement 
for installing the default components.

� This does not include the database software and hardware requirements or 
the additional persistent storage for the managed objects.

� You cannot install IBM Director Console separately on the same 
management server as IBM Director Server because IBM Director Server 
provides all the functionalities of IBM Director Console and IBM Director 
Agent. In case you intend to install IBM Director Console on the other server, 
refer to the hardware requirements of IBM Director Console as shown in 
Table 2-1 on page 21 for AIX 5L or Table 2-2 on page 21 for Linux on 
POWER.

Servers running AIX 5L

You have to check if your servers running AIX 5L (including System p servers, 
and JS20 and JS21 blade servers) have the minimum hardware requirements, 
as shown in Table 2-1 on page 21. 

Note: The information presented in this section might not be up to date, as 
new hardware is continuously tested and added to the support list. Always 
check the latest requirements at:

http://www-306.ibm.com/software/tivoli/products/directory-server/req
uirements.htm
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Table 2-1   Minimum hardware requirements for servers running AIX 5L

Servers running Linux on POWER
We recommend that you ensure minimum hardware requirements before 
installing IBM Director 5.20 on Linux on POWER running on System p servers, 
and JS20 and JS21 blade servers. See Table 2-2.

Table 2-2   Minimum hardware requirements for servers running Linux on POWER

Minimum software requirements
IBM Director 5.20 supports several operating systems such as AIX 5L, Red Hat 
Linux and SUSE Linux running on System p servers, and JS20 and JS21 blade 
servers. Refer to Table 2-3 on page 22. We recommend that you consider the 
following information while preparing the installation of IBM Director 5.20.

� IBM Director provides Level-0 (agentless) support for all operating systems, 
which provides Discovery, Remote Session, and a limited subset of the 
Software Distribution task.

Requirements IBM Director Server IBM Director Console IBM Director Agent

Microprocessor POWER4™ or 
POWER5™ 1.5 GHz

POWER4 or POWER5 
1.5 GHz

POWER4 or POWER5 
1.5 GHz

Memory (RAM) 512 MB (minimum)
1024 MB (recommended)

512 MB (minimum) 512 MB (minimum)

Disk space 325 MB (/opt)
8 MB (usr)

185 MB (/opt)a

6 MB (/usr)

a. Includes the disk space required for IBM Director Agent

90 MB (/opt)
3 MB (/usr)

Display At least 256 colors At least 256 colors N/A

Requirements IBM Director 
Server

IBM Director 
Console

IBM Director 
Agent (Level 2)

IBM Director 
Core Services 
(Level 1)

Microprocessor POWER4 or 
POWER5 1.5 GHz

POWER4 or 
POWER5 1.5 GHz

POWER4 or 
POWER5 1.5 GHz

POWER4 or 
POWER5 1.5 GHz

Memory (RAM) 512 MB 
(minimum)
1024 MB 
(recommended)

512 MB 
(minimum)

512 MB 
(minimum)

128 MB 
(minimum)

Disk space 425 MB 225 MB 170 MB 100 MB

Display At least 256 colors At least 256 colors N/A N/A
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� IBM Director Server and IBM Director Console cannot be installed on the 
same system as IBM Director Server on System p servers, and JS20 and 
JS21 blade servers running AIX 5L or Linux on POWER.

Table 2-3   Operating systems supported by IBM Director on System p, JS20 and JS21 servers

In addition to the operating system requirements, you should verify that the 
prerequisite filesets for AIX 5L or Linux on POWER are installed. Some 
components of IBM Director 5.20 might not be installed if the prerequisites are 
missing. See the prerequisites for IBM Director 5.20 for AIX 5L in 2.2, 
“Installation on AIX 5L” on page 27, and for Linux on POWER in 2.3, “Installation 
on Linux on POWER” on page 33.

2.1.2  IBM Director 5.20 implementation phases on AIX 5L

In this section, we describe the overall implementation steps of IBM Director 5.20 
on AIX 5L. Generally, we can state that it is simpler to install IBM Director 5.20 on 
AIX 5L than Linux on POWER, because most of the filesets related to 
IBM Director 5.20 are packaged to be easily implemented. Before starting the 
installation of IBM Director 5.20, you should verify whether the System p server 
meets the hardware requirements and has the prerequisite filesets.

Make sure that the System p server has the following prerequisite filesets:

� Open SSL fileset

– openssl-0.9.6k-2.aix5.1.ppc.rpm (or later)

Operating system IBM Director 
Server

IBM Director 
Console

IBM Director 
Agent (Level-2)

IBM Director 
Core Services 
(Level-1)

AIX 5L 5.3 (TL3 or later)a

a. IY78923 and IY76140 is required for AIX 5L 5.3 running a 64-bit kernel

Yes Yes Yes

AIX 5L 5.2 (TL5 or later)b

b. IY78923 and IY76141 is required for AIX 5L 5.2 running a 64-bit kernel

Yes

Red Hat Enterprise Linux AS 
4.3 and 4.4 for IBM POWER

Yes Yes Yes Yes

SUSE Linux Enterprise 
Server 10 for IBM POWER

Yes Yes Yes Yes

SUSE Linux Enterprise 
Server 9 for IBM POWERc

c. Service Pack 3 is required for SUSE Linux Enterprise Server 9

Yes Yes Yes Yes
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� Pegasus CIM server filesets

– sysmgt.pegasus.cimserver 2.5.1.0 (or later) 
– sysmgt.pegasus.osbaseproviders 1.2.6.0 (or later)
– sysmgt.pegasus.smisproviders 1.1.0.0 (or later)

� APAR fixes of AIX 5L

– IY78923 is required for all supported versions of AIX 
– IY76140 is required for AIX 5.3 running a 64-bit kernel 
– IY76141 is required for AIX 5.2 running a 64-bit kernel

� Required fileset for IBM Director Console-Hardware Management Console 
(HMC) integration extension

– sysmgt.websm
– sysmgt.sguide

When the hardware and software environment is ready, you can start the 
installation of IBM Director Server 5.20 after verifying the following check points: 

Uninstall the existing IBM Director components when you have IBM Director on 
the same system.

Install and configure DB2 or Oracle® as IBM Director database in case you do 
not use the default database (Apache Derby).

Modify the installation settings in the dirserv.rsp file to customize installation.

Next, start the installation of IBM Director Server 5.20 by using one of the 
following commands, depending on how you want to supply the installation data:

� Install all the components of IBM Director Server (recommended for 
interactive installation):

./dirinstall 2>&1 | tee /tmp/dirinstall.log

� Or, install IBM Director Server using a response file:

./dirinstall -r /directory/response.rsp

If you complete the IBM Director Sever 5.20 installation, you can manage it by 
using the following commands:

� To start:

# /opt/ibm/director/bin/twgstart

� To stop:

# /opt/ibm/director/bin/twgstop

� To start the Console:

# /opt/ibm/director/bin/twgcon
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IBM Director Agent 5.20 requires the following prerequisite filesets:

� Open SSL fileset

– openssl-0.9.6k-2.aix5.1.ppc.rpm (or later)

� Pegasus CIM server filesets

– sysmgt.pegasus.cimserver 2.5.1.0 (or later) 
– sysmgt.pegasus.osbaseproviders 1.2.6.0 (or later)
– sysmgt.pegasus.smisproviders 1.1.0.0 (or later)

To start the installation of IBM Director Agent 5.20, make sure that you are in 
directory where the installation filesets reside, and then use the following script:

# ./dir5.20_agent_aix.sh

The script automatically extracts several install-time extensions and installs the 
IBM Director Agent code as well. 

To start the IBM Director Agent, use the same command as for the IBM Director 
Server:

# /opt/ibm/director/bin/twgstart

2.1.3  Implementation of IBM Director 5.20 for Linux for POWER

This section covers the steps that you should follow to implement a management 
solution infrastructure based on IBM Director running on Linux on POWER 
systems. Before we start the actual installation process, we have to collect and 
install (if necessary) the prerequisite software components. We also present a 
high-level overview of the installation process and how to start and stop the 
product.

Before you install the IBM Director Server or Agent components, the Linux 
system should meet the applicable requirements for a System p platform, 
meaning that the operating system should be aware of features such as dynamic 
LPAR (DLPAR) or serviceable and informational hardware events that the 
POWER platform can provide.

For Linux on POWER, a set of packages has to be installed first. These 
packages can be downloaded from the IBM Web site, the “Service and 
productivity tools” section for the Linux on POWER platforms that can be found 
at:

http://www14.software.ibm.com/webapp/set2/sas/f/lopdiags/home.html
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The packages are available for the following Linux distributions:

� Red Hat Enterprise Linux 3 (RHEL3) and Red Hat Enterprise Linux 4 (RHEL4)

� SUSE Linux Enterprise Server 10 (SLES 10), SUSE Linux Enterprise 
Server 9 (SLES 9) and SUSE Linux Enterprise Server 8 (SLES 8)

� Turbolinux Enterprise Server 8 (TLES8)

The POWER-based platforms covered by the packages include the 
HMC-managed or Integrated Virtualization Manager (IVM)-managed servers, 
BladeCenter servers, and other (non-Blade, non-HMC-managed) systems.

For example, at the time of the writing this paper, the packages shown in 
Table 2-4 were available for RHEL4 systems.

Table 2-4   Packages for RHEL4 on POWER for HMC- or IVM-managed environments

Tool name Package name and version

Platform Enablement Library librtas-1.3.0-0.ppc64.rpm

SRC src-1.2.2.1-05054.ppc.rpm

RSCT core & utilities rsct.core.utils-2.4.1.2-05070.ppc.rpm
rsct.core-2.4.1.2-05070.ppc.rpm

CSM core & client csm.core-1.4.0.12-98.ppc.rpm
csm.client-1.4.0.12-98.ppc.rpm

ServiceRM devices.chrp.base.ServiceRM-2.2.0.0-2.ppc.rpm

DynamicRM DynamicRM-1.2-0.ppc.rpm

Service Aids powerpc-utils-1.0.0-1.ppc64.rpm
powerpc-utils-papr-1.0.3-1.ppc64.rpm

Hardware Inventory lsvpd-0.15.1-1.ppc.rpm

Service Log servicelog-0.2.2-0.ppc64.rpm

Error Log Analysis diagela-2.1.5-0.ppc64.rpm

PCI Hotplug Tools rpa-pci-hotplug-1.0-18.ppc64.rpm

Dynamic Reconfiguration Tools rpa-dlpar-1.0-25.ppc64.rpm

Inventory Scout IBMinvscout-2.2-5.ppc.rpm

Note: In the case of Red Hat Linux distribution, some of the above packages 
such as csm.client and DynamicRM require the libstdc++ compatibility 
package version 2.96 to be installed on the system. The RPM package name 
is compat-libstdc++-296-2.96-132.7.2.ppc.rpm and for RHEL4 Update 4, it 
can be found on CD#3.
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Based on the RPM dependencies, we recommend that you install the packages 
included in Table 2-4 on page 25 in the order listed in the table, in order to have 
the Linux system ready for any DLPAR operations. More information about the 
tools and functionality that these packages provide can be found at:

http://www14.software.ibm.com/webapp/set2/sas/f/lopdiags/info/resources
.html

The minimum set of packages that have to be installed on RHEL4, SLES 9, and 
SLES 10 systems before any IBM Director 5.20 Server or Agent installation on a 
POWER platform is included in the following list:

� librtas-1.2-1.ppc64.rpm
� lsvpd-0.12.7-1.ppc.rpm
� diagela-2.1.5-0.ppc64.rpm
� servicelog-0.2.1-2.ppc64.rpm
� powerpc-utils-1.0.0-1.ppc64.rpm
� powerpc-utils-papr-1.0.3-1.ppc64.rpm

After the prerequisite packages are installed, you can start the installation 
process by running the utility corresponding to the product component image:

� To install the IBM Director Server:

# ./dirinstall 

� To install the IBM Director Agent Level 2:

# ./dir5.20_agent_linppc.sh

� To install the IBM Director Agent Level 1:

# ./cs5.20_agent_linppc.sh

� To install the IBM Director Console:

# ./dirinstall 

The installer performs the basic verifications and deploys the RPM packages on 
the system. When the installation has finished, for both server and agent you can 
use the following commands:

� To start:

# /opt/ibm/director/bin/twgstart

� To stop:

# /opt/ibm/director/bin/twgstop

� To start the Console:

# /opt/ibm/director/bin/twgcon
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The same command can be used for the server and the agent because the 
server installation comes by default with the agent (and the console), therefore at 
the server side, running twgstart starts the server components processes, which 
also include the agent functionality. The IBM Director Server system can also be 
discovered and managed as a Level-2 Agent system.

The IBM Director Console can be started using:

# /opt/ibm/director/bin/twgcon

Because the console is a graphical user interface (GUI) based application, it 
requires a DISPLAY, which can be provided by a local X server, or by an external 
(remote) X server. You can also use the VNC server on your system, which is 
seen as a local X server, and you connect to it remotely using a VNC console 
session.

Detailed information about installing the prerequisite packages and the 
IBM Director Server, Agent, and Console components can be found in 2.3, 
“Installation on Linux on POWER” on page 33.

2.2  Installation on AIX 5L

This section covers the installation of IBM Director Server on AIX 5L.

2.2.1  IBM Director 5.20 and prerequisite software

To install IBM Director Server 5.20 on AIX 5L, you require IBM Director 5.20 
software and also the prerequisite filesets. 

1. You can obtain the IBM Director 5.20 software for AIX 5L from the following 
sources. 

a. Download the IBM Director 5.20 file from the IBM Director Web site:

http://www-03.ibm.com/servers/eserver/xseries/systems_management/
xseries_sm/dwnl.html

b. Select IBM Director for pSeries at Step 1: Choose software. Type your 
name and e-mail address at Step 2: Download software, and click Submit 
button.

Note: You require an IBM ID and password. If you do not have one, you 
can register on the Web. Allow 24 hours for the registration process to 
complete.
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c. Select IBM Director Server, Agent and Console for AIX, and download 
it.

2. You require Pegasus CIM Server for IBM Director 5.20 installation. 

Visit the following Web site:

http://www-03.ibm.com/servers/eserver/xseries/systems_management/xse
ries_sm/dwnl.html

a. In this page, select IBM Director for pSeries at Step 1: Choose software. 

b. Download IBM Pegasus CIM Server and Providers for AIX 2.5.1 files.

c. Unzip and extract its contents by typing the following commands: 

# gzip -cd Pegasus2.5.1.0_AIX.tar.gz | tar -xvf -
# gzip -cd OSProviders1.2.6.0_SMISProviders1.1.0.0_AIX.tar.gz | tar 
-xvf -

2.2.2  Preparing to install IBM Director 5.20 on AIX 5L

Before installing IBM Director Server on a System p platform, make sure that 
your platform meets the requirements. Consider the following information:

1. Ensure that the following AIX Pegasus CIM Server and providers are installed 
and functional: 

– openssl-0.9.6k-2.aix5.1.ppc.rpm (or later) 

Check to see if openssl packages are installed. If not, install it as shown in 
Example 2-1.

Example 2-1   Installing openssl package

dirms520aix:> rpm -qa | grep -i openssl
dirms520aix:> rpm -ivh openssl-0.9.7g-1.aix5.1.ppc.rpm
openssl #########################################
dirms520aix:> rpm -qa | grep -i openssl
openssl-0.9.7g-1

– sysmgt.pegasus.cimserver 2.5.1.0 (or later) 
– sysmgt.pegasus.osbaseproviders 1.2.6.0 (or later)
– sysmgt.pegasus.smisproviders 1.1.0.0 (or later)

Make sure that all three filesets are installed. If not, you install them by SMIT 
(or the installp command).

For more information about requirements and how to install OpenSSL and 
Pegasus, see the System p and AIX information center at:

http://publib.boulder.ibm.com/infocenter/pseries/index.jsp
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To view these documents, type cim server as search key into the Search box 
on the left and then click Install the Pegasus CIM Server and base providers 
in the Search Results. The information center contains instructions about how 
to use the lslpp -l command to verify that the installed Pegasus filesets are at 
the required version. It also describes how to verify which version of OpenSSL 
is installed and how to obtain the correct version of this RPM. 

2. Verify that the required APAR fixes are installed on your system. 

– IY78923 is required for all supported versions of AIX 
– IY76140 is required for AIX 5.3 running a 64-bit kernel 
– IY76141 is required for AIX 5.2 running a 64-bit kernel

Complete the following steps to verify that you have the required fixes 
installed. 

a. Type the following command and press Enter: 

# instfix -i -k " IY76140 IY78923" 

b. Check to see if the filesets incorporating these APAR fixes are installed. 

IY78923 is included in the following filesets: 

• xlC.aix50.rte (version 8.0.0.5 or later)
• xlC.rte (version 8.0.0.5 or later)
• xlsmp.aix50.rte (version 1.6.0.0 or later)
• xlsmp.rte (version 1.6.0.0 or later)

IY76140 is included in the following fileset: 

• bos.mp and bos.mp64 (version 5.3.0.40 or later)

These filesets are included in AIX 5L 5.3 TL4 or later.

c. If any filesets are not installed, download and install the required APARs 
from the Fix Central Web site at:

http://www.ibm.com/eserver/support/fixes/fixcentral

3. Make sure that these prerequisites are installed for IBM Director 
Console-HMC integration extension:

– sysmgt.websm
– sysmgt.sguide

4. We also recommend that you back up the CIM repository. Use the commands 
shown in Example 2-2.

Example 2-2   Backing up the CIM repository

dirms520aix:> /opt/freeware/cimom/pegasus/bin/cimserver -s
PGS10019: CIM server is stopped.
dirms520aix:> cp -pRh /opt/freeware/cimom/pegasus/etc/repository 
/opt/freeware/cimom/pegasus/etc/repository.backup.20061012
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dirms520aix:/opt/freeware/cimom/pegasus/etc> ls -l repository.back*
total 0
drwxr-xr-x 5 root system 256 Sep 29 01:03 root
drwxr-xr-x 5 root system 256 Sep 29 01:03 root#PG_InterOp
drwxr-xr-x 5 root system 256 Sep 29 01:03 root#PG_Internal
drwxr-xr-x 5 root system 256 Sep 29 01:03 root#cimv2
dr-xr-xr-x 5 root system 256 Sep 29 01:03 root#ibmsd
drwxr-xr-x 5 root system 256 Oct 10 13:11 root#ibmsd_remote

Additional configuration and troubleshooting information about the AIX 
Pegasus CIM Server is available in the following two documents: 

– The Common Information Model Guide for AIX, which is available at:

http://publib.boulder.ibm.com/infocenter/pseries/v5r3/topic/com.i
bm.aix.doc/aixbman/cim/cim.pdf 

– The README file that is installed with the sysmgt.pegasus.cimserver 
fileset in /opt/freeware/cimom/pegasus/

Refer to these documents if you encounter problems running the AIX 
Pegasus CIM Server. The guide and the README file contain instructions on 
repository recovery (if needed).

2.2.3  Installing IBM Director Server 5.20 on AIX 5L

After preparing your system, you can install IBM Director Server on AIX by 
downloading the AIX installation file, or by using the IBM Director for AIX 5L 
V5.20 CD. You can perform a standard installation or you can use a response file 
to customize the features that are installed.

Notes: 

� IBM Director Server and IBM Director Console must be at the same 
release level.

� If you are planning to install and use a database for IBM Director other than 
the default database, make sure that you have installed and configured the 
database application before installing IBM Director Server.

� IBM Director Server includes all the functionalities of IBM Director Agent 
and IBM Director Console. It is not possible (nor necessary) to separately 
install either IBM Director Agent or IBM Director Console on the 
management server after installing IBM Director Server.

� Before installing IBM Director Server on a system that has IBM Director 
Console or IBM Director Agent installed, you must first uninstall the 
existing IBM Director components.
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1. Prepare the IBM Director 5.20 installation image.

2. Start to install IBM Director Server as shown in Example 2-3. 

The dirinstall script automatically installs IBM Director Server, Director 
Agent, and install-time extensions (unless you use a response file to 
customize the features to be installed).

Example 2-3   Installing IBM Director Server 5.20 using dirinstall script

dirms520aix:/kits/dir520/server/aix> chmod +x dirinstall
dirms520aix:/kits/dir520/server/aix> ./dirinstall 2>&1 | tee 
/tmp/dirinstall.log

**********************************************************************
This Program is licensed under the terms of the agreement located in 
the license file in the Program's installation license folder or in the 
license folder on the source media.
By installing, copying, accessing, or using the Program, you agree to 
the terms of this agreement. If you do not agree to the terms, do not 
install, copy, access, or use the Program.
**********************************************************************
......................

3. To start IBM Director Server, type the twgstart command. Then check to see 
if IBM Director Server is running by typing twgstat command. See 
Example 2-4.

Example 2-4   Starting IBM Director Server 5.20 on AIX 5L

dirms520aix:/opt/ibm/director/bin> ./twgstart
Service started.
dirms520aix:/opt/ibm/director/bin> ./twgstat
Active

4. To start IBM Director Console, type this command and press Enter.

/opt/ibm/director/bin/twgcon

If you want to access IBM Director Console on systems that do not have local 
display such as JS20 and JS21, you have to export Director Console using 
either the xhost command or Secure Shell (SSH) tunneling.

Note: To uninstall IBM Director Server, you should use the 
/opt/ibm/director/bin/diruninstall command instead of using SMIT.
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2.2.4  Installing IBM Director Agent 5.20 on AIX 5L

IBM Director 5.20 provides System p servers, and JS20 and JS21 servers that 
run AIX 5L 5.3 or AIX 5L 5.2 with Level-0 (Agentless) or Level-2 IBM Director 
Agent. IBM Director Server can discover the managed servers without any 
IBM Director Agent (Level-0), but it provides a limited amount of information to 
the system administrator. If you do not intend to install IBM Director Agent on 
AIX 5L, but still want to manage the server using IBM Director, we recommend to 
discover the server as a Simple Network Management Protocol (SNMP) device.

Level-2 Agent installation
In this section, we describe how to install Level-2 IBM Director Agent on AIX 5L.

1. Ensure that the following prerequisite filesets are installed (see Example 2-5):

– openssl-0.9.6k-2.aix5.1.ppc.rpm (or later)
– sysmgt.pegasus.cimserver 2.5.1.0 (or later) 
– sysmgt.pegasus.osbaseproviders 1.2.6.0 (or later)
– sysmgt.pegasus.smisproviders 1.1.0.0 (or later)

Example 2-5   Prerequisites checking that IBM Director Agent 5.20 is installed on AIX 5L

aixmp10:> rpm -qa | grep -i openssl
openssl-0.9.7g-1
aixmp10:> /opt/freeware/cimom/pegasus/bin/cimserver -v
2.5.1

2. Verify that the IBM Director Agent code to be installed is at the same level as 
IBM Director Server. 

3. Start to install IBM Director Agent 5.20 on AIX 5L. The installation file 
(dir5.20_agent_aix.sh) is located in the FILES directory of your IBM Director 
Agent 5.20 installation image file system. See Example 2-6.

Example 2-6   Installing IBM Director Agent 5.20 on AIX 5L

aixdoumi:> /mnt/kits/aix/FILES> chmod +x dir5.20_agent_aix.sh
aixdoumi:> /mnt/kits/aix/FILES> ./dir5.20_agent_aix.sh

./dir5.20_agent_aix.sh self-extracting installation program... Please 
wait...

....... (Omitted lines) ......

Installation of selected components is successful.
To start IBM Director Agent manually, run 
/opt/ibm/director/bin/twgstart
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4. To start IBM Director Agent, type the twgstart command and then check to 
see if IBM Director Agent is running by typing twgstat command, as shown in 
Example 2-7.

Example 2-7   Starting IBM Director Agent 5.20 on AIX 5L

aixdoumi:/opt/ibm/director/bin> ./twgstart
Service started.
aixdoumi:/opt/ibm/director/bin> ./twgstat
Active

2.3  Installation on Linux on POWER

This section covers the installation of IBM Director Server and Level-1 and 
Level-2 Agents on IBM System p running Linux (Linux on POWER).

2.3.1  Obtaining the installation files

To prepare the system before installing the IBM Director Server or Agent 
components, you should first install the prerequisites packages listed in Table 2-2 
on page 21 in “Servers running Linux on POWER” on page 21.

The IBM Director for Linux on POWER product can be downloaded from the 
IBM Director Web site:

http://www.ibm.com/systems/management/director 

In case you have the IBM Director for Linux on POWER, V5.20 CD, mount it and 
start the installation process for the IBM Director Server component. The same 
installation sources are available for IBM Director Agent, IBM Director Core 
Services (formerly known as Level-1 Agent), and IBM Director Console images 
for the POWER platforms.

The following sections cover the installation of the server and Level-2 Agent 
components. The information presented applies also for the Level-1 Agent 
because the installation process does not differ from the Level-2 Agent 
installation process.
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2.3.2  Installing the prerequisites

When the prerequisite files have been downloaded to a local directory, we can 
start installing them one by one in the order shown in the following list. You can 
also install them all together. To install a package, use the following command:

rpm -ivh <package>.rpm

Where <package>.rpm is the name of the package.

Starting with the requirements specified in the IBM Director Planning, 
Installation, and Configuration Guide for installing the IBM Director Server or 
Agent components, and the files available online at the time of writing this paper, 
the minimum set of packages required is:

� librtas-1.3.0-0.ppc64.rpm
� lsvpd-0.15.1-1.ppc.rpm
� servicelog-0.2.2-0.ppc64.rpm
� diagela-2.1.5-0.ppc64.rpm
� powerpc-utils-1.0.0-1.ppc64.rpm
� powerpc-utils-papr-1.0.3-1.ppc64.rpm

The RPM files (or later versions) in the previous list have to be installed for 
RHEL4, SLES 9, and SLES 10 systems.

Distribution-specific considerations
For RHEL4 systems, before installing IBM Director, ensure that the 
compat-libstdc++-33-3.2.3-47.3.ppc.rpm file (or later version) is installed. 

If you intend to install the rest of the packages listed in Table 2-4 on page 25, 
packages such as csm.client and DynamicRM might require the 
compat-libstdc++-296-2.96-132.7.2.ppc.rpm file also to be installed.

Packages conflicts
Depending on the POWER platform (System p or BladeCenter), there might be 
cases when one or more of the new packages that you have to install are in 
conflict with an existing vendor-provided package installed by default with the 
Linux operating system. In Example 2-8 on page 35 and Example 2-9 on 
page 35, we present the installation options for RHEL4 and SUSE 10 systems 
that we have used in our testing environment.

Tip: In case of a file conflict reported when installing an RPM package, use 
the --Uvh --force option to install the package. This might apply to the 
librtas-1.3.0-0.ppc64.rpm, powerpc-utils-1.0.0-1.ppc64.rpm, and 
powerpc-utils-papr-1.0.3-1.ppc64.rpm files on SLES 10 and RHEL4.
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In the outputs in Example 2-8 and Example 2-9, we include the installation output 
of the minimum set of packages required.

Example 2-8   Installing the prerequisites for IBM Director Server/Agent

# rpm -ivh librtas-1.3.0-0.ppc64.rpm
Preparing... ########################################### [100%]
   1:librtas ########################################### [100%]
# rpm -ivh lsvpd-0.15.1-1.ppc.rpm
Preparing... ########################################### [100%]
   1:lsvpd ########################################### [100%]
# rpm -ivh servicelog-0.2.2-0.ppc64.rpm
Preparing... ########################################### [100%]
   1:servicelog ########################################### [100%]
# rpm -ivh diagela-2.1.5-0.ppc64.rpm
Preparing... ########################################### [100%]
   1:diagela ########################################### [100%]
Starting rtas_errd (platform error handling) daemon: [  OK  ]
#

The servicelog, diagela, and powerpc-utils packages are required by 
IBM Director Core Services (formerly known as Level-1 Agent) and IBM Director 
Level-2 Agent too, because the Level-1 Agent is also a base for Level-2 Agent. 

The RHEL4 installation comes with the ppc64-utils package and SLES 10 
supplies the powerpc-utils package (installed by default). These packages 
conflict with the powerpc-utils packages provided by IBM. To install the 
powerpc-utils RPMs, the rpm --Uvh --force installer flags must be used as 
shown in Example 2-9.

Example 2-9   Installing the prerequisites for IBM Director Server/Agent (continued)

# rpm -Uvh --force powerpc-utils-1.0.0-1.ppc64.rpm
Preparing... ########################################### [100%]
   1:powerpc-utils ########################################### [100%]
# rpm -Uvh --force powerpc-utils-papr-1.0.3-1.ppc64.rpm
Preparing... ########################################### [100%]
   1:powerpc-utils-papr     ################################### [100%]
#

After these steps, the system is ready for the IBM Director Server and agents 
installation.
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2.3.3  Installing IBM Director Server 5.20 on Linux on POWER

The installation of IBM Director components can be performed in an interactive 
(standard) way or you can use a response file to customize the features to be 
installed.

The standard installation is a straightforward process. You have to run the 
dirinstall utility from the directory where the installation image files have been 
extracted (or from the CD mount point), and the filesets are installed on the 
system. In case the system has the IBM Director Console or IBM Director Agent 
components already installed, you must first uninstall these components 
because the IBM Director Server includes the functionality for both the agent and 
the console.

You can download the IBM Director for Linux on POWER, Version 5.20 image 
(DIr5.20_LinuxonPower.tar.gz) from the IBM Director Web site at:

http://www.ibm.com/systems/management/director

Then extract the archive using:

gzip -cd Dir5.20_LinuxonPower.tar.gz | tar -xvf -

Start the installation from the same directory by running (see Example 2-10):

./dirinstall

In case you have the IBM Director for Linux on POWER, V5.20 CD, mount it and 
run the installer from the right location, using the following commands:

# mount /dev/cdrom /mnt/cdrom
# cd /mnt/cdrom/director/server/linux/ppc
# ./dirinstall

In the previous example cdrom is the CD drive device and /mnt/cdrom is the 
mount point for the ISO file system.

Example 2-10   Installation of IBM Director Server and basic verification steps

# ./dirinstall

***********************************************************************
This Program is licensed under the terms of the agreement located in 
the license file in the Program's installation license folder or in the 
license folder on the source media.
By installing, copying, accessing, or using the Program, you agree to 
the terms of this agreement. If you do not agree to the terms, do not 
install, copy, access, or use the Program.
***********************************************************************
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Attempting to install ITDServer-5.20-1.ppc.rpm
Preparing...                
##################################################
ITDServer                   
##################################################

... (content omitted) ...

Attempting to install HMCConsoleExt-5.20-1.noarch.rpm
Preparing...                
##################################################
HMCConsoleExt               
##################################################

Installation of selected components is successful.
To start IBM Director Server manually, run 
/opt/ibm/director/bin/twgstart
#
# /opt/ibm/director/bin/twgstat
Inactive
# /opt/ibm/director/bin/twgstart
Service started.
# /opt/ibm/director/bin/twgstat
Active

This concludes the installation of IBM Director Server, and the basic checks 
performed.

2.3.4  Installing IBM Director Agent 5.20 on Linux on POWER

The installation of the Level-2 Agent component is slightly different from the 
installation process of the Server component. To make sure that the system is 
ready for the installation, you should follow the instructions in 2.3.2, “Installing the 
prerequisites” on page 34. 

When the system has all the prerequisites installed, we can start installing the 
Level-1 Agent: IBM Director Agent for Linux on POWER or Level-2 Agent: 
IBM Director Agent for Linux on POWER.

There are two methods: 

� Downloading the installation image from Internet:

http://www.ibm.com/systems/management/director

� Using the CD
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Example 2-11 presents the installation of Level-2 Agent on IBM System p 
running Linux.

Example 2-11   Installation of Level 2: IBM Director Agent on Linux on POWER

]# ./dir5.20_agent_linppc.sh

./dir5.20_agent_linppc.sh self-extracting installation program... 
Please wait...

**********************************************************************
This Program is licensed under the terms of the agreement located in 
the license file in the Program's installation license folder or in the 
license folder on the source media.
By installing, copying, accessing, or using the Program, you agree to 
the terms of this agreement. If you do not agree to the terms, do not 
install, copy, access, or use the Program.
**********************************************************************

Attempting to install ITDAgent-5.20-1.ppc.rpm
Preparing...                
##################################################
ITDAgent                    
##################################################

... (content omitted) ...

compiling IndicationSchema.mof

Setup filters using batch file -> 
/opt/ibm/director/cimom/bin/pSeriesLinuxIndicationSettingsFilters.dat
Number of filters now active  ===>
21
Setup subscriptions using batch file -> 
/opt/ibm/director/cimom/bin/pSeriesLinuxIndicationSettingsSubscriptions
.dat
Number of subscriptions now active  ===>
42
Attempting to install ColSrvDirExt-5.20-1_RHEL4.ppc.rpm
Preparing...                
##################################################
ColSrvDirExt                
##################################################
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If the IBM Director agent is running, restart the agent to activate the 
extension.

Installation of selected components is successful.
To start IBM Director Agent manually, run 
/opt/ibm/director/bin/twgstart
#
# /opt/ibm/director/bin/twgstat
Inactive
# /opt/ibm/director/bin/twgstart
Service started.
# /opt/ibm/director/bin/twgstat
Active
#
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Chapter 3. Scenarios

In this chapter, we present practical examples of how to use IBM Director for 
System p specific tasks. In the ITSO lab, we have tested various configurations 
and implemented IBM Director to monitor using different agent levels to monitor 
System p hardware, including Hardware Management Console (HMC) and 
Integrated Virtualization Manager (IVM).

This chapter describes the following scenarios:

� Hardware Management Console managed environment

� Integrated Virtualization Manager managed environment

� Working with agentless (including SNMP) systems

� Using Software Distribution

3
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3.1  Hardware Management Console managed 
environment

In this scenario, we cover the integration of IBM Director with an HMC system 
used for managing one or more IBM System p5 servers. As a hardware control 
point, HMC provides access to features such as logical partition (LPAR) 
management, Micro-Partitioning, and dynamic LPAR (DLPAR) operations.

The HMC extension is automatically installed with IBM Director Server and 
IBM Director Console on the following management servers and management 
consoles: AIX 5L, i5/OS, and Linux on IBM System p5 servers.

You can check the installed HMC extension of IBM Director Server on AIX 5L by 
typing the lslpp -l HMC* command, as shown in Example 3-1.

Example 3-1   Verifying HMC extension installed on AIX 5L

dirms520aix:/> lslpp -l HMC*
  Fileset                   Level  State      Description
-----------------------------------------------------------------------
Path: /usr/lib/objrepos
  HMCCommonExt           5.20.0.0  COMMITTED  Director HMC Common Code Extension for AIX
  HMCConsoleExt          5.20.0.0  COMMITTED  Director HMC Console Extension for AIX

The rpm -qa | grep -i hmc command reveals whether the HMC extensions of 
IBM Director Server are installed on Linux on POWER, as shown Example 3-2.

Example 3-2   Verifying whether HMC extension is installed on Linux on System p5 server

[root@dirmsred /]# rpm -qa | grep -i hmc
HMCServerExt-5.20-1
HMCCommonExt-5.20-1
HMCConsoleExt-5.20-1

The diagram in Figure 3-1 presents the environment that we used for testing the 
examples described in this section.

Note: IBM Director Server’s HMC support is provided by an extension 
installed automatically with the Director software, therefore you do not have to 
install additional extensions.
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Figure 3-1   Scenario 2: Hardware Management Console managed environment

Discovering the Hardware Management Console 
In order to manage and monitor HMC through IBM Director Server, you have to 
add the HMC definition to the IBM Director Server database. We recommend 
that you use the automatic discovery process for the HMC, rather than manually 
adding it to the system. Before running automatic discovery, you can change 
certain HMC discovery options in Discovery Preferences under the Options 
menu.

To run Discover: 

1. From the central panel of the IBM Director Console, use your mouse and 
right-click to select Discover → HMC. Wait for the IBM Director Server to find 
the new HMC machine, as shown in Figure 3-2.
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Figure 3-2   Activating the HMC discovery process in IBM Director Console

2. Click the HMC and HMC Members icon in the left panel to check if the new 
HMC machine has been discovered. You can see an HMC for System p5 570 
shown in Figure 3-3 on page 45.

Even if the System State is displayed as Unknown, you can ignore this for the 
moment, as this will be soon changed to Online after performing the following 
steps.

Another way to check the current state of the HMC is by right-clicking the 
HMC machine name and then selecting Presence Check. You can also 
right-click the HMC and select Open to view the general attributes of a 
managed server, in this case the HMC.
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Figure 3-3   Viewing the general attributes of HMC as a managed server

3. To activate the integrated HMC support menu on IBM Director Console, you 
have to grant access to the HMC. To do this, right-click the HMC and then 
select Request Access. In the dialog box, type the HMC user ID (usually 
“hscroot”), and the password for this ID, as shown in Figure 3-4.
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Figure 3-4   Requesting access to an HMC

4. In this step, we list the newly integrated HMC-related menus on the 
IBM Director Console (see Figure 3-5). The HMC Manager Tools that are 
integrated with IBM Director Consoles are:

– Server and Partition Management

• Frame Management
• Server Management

– Licensed Internal Code Maintenance

• HMC Code Update
• Licensed Internal Code Updates

– HMC Management

• HMC Users
• HMC Configuration

– Information Center and Setup Wizard

– Service Focal Point

– Delete HMC Console login credential
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Figure 3-5   Figuring out the HMC Manager Tools menu on IBM Director Console

When you run one of these tools, an HMC Web-based System Manager 
(WSM) window is launched and you can go to the selected tool (screen). You 
can also manage Central Electronics Complex (CEC) and HMC-managed 
LPARs. We discuss the detailed CEC support functionality later in this 
scenario.

5. You can see all the HMC-managed LPARs that are discovered by 
IBM Director Server regardless of the IBM Director Agent level. Click the 
HMC and HMC Members icon in the left panel, and observer the HMC, CEC, 
and HMC-managed LPARs, as shown in Figure 3-6.
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Figure 3-6   HMC, CEC, and HMC-managed logical partitions

Working with HMC Manager Tools
When you select HMC functions provided by IBM Director Console, an HMC 
WSM window is started.

1. Click the HMC and HMC Members icon in the left panel. Go to the central 
panel of IBM Director Console and right-click the managed object 
representing the HMC, and go to HMC Manager Tools. Select the task that 
you want to run.

2. Provide HMC credentials (user ID and password) to launch the HMC WSM 
console. Usually, this is the hscroot user. See Figure 3-7.
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Figure 3-7   Running HMC Manager Tools of IBM Director Console

Managing Central Electronics Complex and LPARs
In addition to the HMC Manager Tools, IBM Director Server provides support for 
managing CECs. For example, you can power-on or power-off an IBM System p 
server hardware managed by HMC through IBM Director Console.

1. Start by clicking the HMC and HMC Members icon in the Groups panel on 
the left. Go to the central panel and right-click the physical platform that 
represents the System p server hardware. Select Power Management from 
the menu in order to turn System p server on or off. See Figure 3-8.

 

 

 

 

 Chapter 3. Scenarios 49



Figure 3-8   Managing Central Electronics Complex using IBM Director Console

2. You can schedule another time to turn System p server on or off by selecting 
the Schedule button. To turn it on or off immediately, click the Execute Now 
button. See Figure 3-9.
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Figure 3-9   Selecting power-on or power-off time

You can also manage LPARs managed by an HMC. If the LPAR is activated, you 
can restart or power it off. Otherwise, you can activate LPARs through the 
IBM Director Console. 

Click the HMC and HMC Members icon in the Groups panel on the left. Go to 
the central panel and right-click the logical platform representing an LPAR 
managed by the HMC. Select Power Management menu in order to activate or 
deactivate the LPAR. 

You can also select Schedule for planning the action at a later time, or you can 
click Execute Now to take action immediately. See Figure 3-10. If the Power 
Management menu still presents the old menu (even though you turned 
on/turned off LPAR), you can re-check the current LPAR status by clicking HMC 
Manager Tools → Server and Partition Management → Server 
Management.
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Figure 3-10   Managing LPAR by IBM Director Console

Configuring HMC to send serviceable events to IBM Director
One HMC can manage several IBM System p5 servers. Each server can send 
informational or warning messages to the HMC and these messages are 
collected by the HMC as serviceable events.

The serviceable events collected by the HMC can also be forwarded as Simple 
Network Management Protocol (SNMP) traps to the IBM Director Server. HMC 
software has the capability to notify an SNMP manager about any new (SNMP) 
event. This is the Customer Notification feature of the Service Agent component.

To configure the HMC to send events to an IBM Director server, we have to 
connect to HMC using the WSM client or from the IBM Director Console (the 
HMC Extension must be installed). The WSM navigation path is 
<HMC-hostname> → Service Applications → Service Agent → Customer 
Notification. 

1. From the IBM Director Console, you have to right-click the HMC system and 
select HMC Manager Tools → Service Focal Point. 

2. Provide the credentials and log in to the graphical user interface (GUI). 

3. Select the Service Agent icon from the Navigation Area pane and click the 
Customer Notification in the Service Agent Configuration pane.

4. Customer Notification feature can send messages to the IBM Director when a 
service events occurs on the HMC or on the connected systems. From the 
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Customer Notification dialog, you select the SNMP Trap Configuration tab 
and add the IP address of the IBM Director Server system and the public 
community name, as shown in Figure 3-11.

Figure 3-11   Customer Notification feature on HMC to send SNMP messages

Generating serviceable events
In order to test that the HMC can send serviceable events (as SNMP messages) 
to the IBM Director Server, we have to generate a serviceable event. For this 
example, we choose one AIX LPAR from an IBM System p5 server managed by 
the HMC previously configured.

To generate a serviceable event from in AIX system, we use the diag utility. 

1. To generate such an event, we run diag in a shell prompt. 

2. In the FUNCTION SELECTION menu, we go to Advanced Diagnostics 
Routines and select Problem Determination. 

3. From the list of the resources, we select the Operator panel (oppanel) 
resource by moving the cursor to it and pressing Enter. 

4. We press F7 to continue, and finish by selecting YES to create a test 
Serviceable Event.
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Later we can observer the event in the HMC Service Focal Point using the HMC 
Manager Tools provided in the IBM Director Console, or just running the 
following command from a Secure Shell (SSH) session on the HMC console:

lssvcevents -t hardware

We can see the serviceable event generated from the AIX logical partition in the 
list of the events, as shown in Example 3-3.

Example 3-3   Description of the serviceable event generated from an LPAR

hscroot@hmc:~> lssvcevents -t hardware
problem_num=14,pmh_num=,refcode=651-199,status=Open,first_time=10/25/20
06 01:37:19,last_time=10/25/2006 
01:37:19,sys_name=Server-9117-570-SN10C5D5C,sys_mtms=9117-570/10C5D5C,e
nclosure_mtms=9117-570/10C5D5C,firmware_fix=,text=This is a test of the 
flow of a Serviceable Event from this system to the Service Focal Point 
on the HMC. This is not a real problem.,created_time=10/25/2006 
01:37:19,reporting_name=Server-9117-570-SN10C5D5C,reporting_mtms=9117-5
70/10C5D5C,failing_mtms=9117-570/10C5D5C,analyzing_hmc=hmcp570,event_ti
me=10/25/2006 02:39:45
... (content omitted) ...

The same event can be seen in the IBM Director Console as a warning message 
associated with the HMC system. Clicking the yellow exclamation symbol 
displayed in the bottom-right corner (see Figure 3-12), we can see the content of 
the message that represents the serviceable event.

Figure 3-12   The warning message associated with the HMC system
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In Figure 3-13, you can see the same service event previously displayed in 
Example 3-3 on page 54. 

Figure 3-13   The generated serviceable event displayed as a warning message

3.2  Integrated Virtualization Manager managed 
environment

IVM support has been introduced in IBM Director version 5.20. This scenario 
discusses how IBM Director 5.20 works with an IVM managed IBM System p5 
server. Throughout this section, we present this new functionality and how we 
applied it in our environment.

If you have an entry level System p server, such as IBM System p5 510, 
IBM System p5 520, and IBM System p5 550, you can create and manage 
LPARs through IVM, even though HMC is not used. However, IVM does not offer 
all the functionalities that can be achieved through HMC. For example, dynamic 
LPAR (DLPAR) is not available with IVM.

IBM Director 5.20 support for IVM functionality even works with a Level-0 
IBM Director Agent (also known as agentless system), therefore this chapter 
covers a Level-0 Agent environment using an IVM server. The chart shown in 
Figure 3-14 on page 56 helps you to understand the infrastructure that we have 
used for this scenario. 

This scenario presents how to manage an IVM server managed using SNMP in 
IBM Director 5.20, and the tasks for making an IVM server a managed device in 
IBM Director V5.20.
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The environment for this scenario consists of:

� Management Server

– AIX 5L 5.3 TL5 or Red Hat Linux
– IBM Director Server 5.20 (including all the install-time extensions)
– VNC server to enable GUI-based Director Console

� IVM server (managed server)

– Virtual I/O 1.3 Fix Pack 8
– SSH-1.99-OpenSSH_4.3

Figure 3-14   IBM Director 5.20 Scenario: IVM managed environment

Configuring IVM server for IBM Director V5.20
We recommend that you add the IVM server as a Level-0 IBM Director Agent 
(agentless) device using SNMP. As IVM runs in a virtual I/O server (VIOS), you 
perform all tasks through the VIO server. 

Currently, VIOS does not provide any command to start the SNMP daemon with 
padmin user, therefore you should access the AIX 5L V5.3 environment mode 
using the oem_setup_env command. When in AIX environment, (as root) use the 
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System Resource Controller startsrc -s snmpd command to start the snmpd 
daemon. See Example 3-4.

Example 3-4   Starting snmpd daemon on the VIO server

$ oem_setup_env
# lssrc -s snmpd
Subsystem         Group            PID          Status
snmpd            tcpip                         inoperative
# startsrc -s snmpd
0513-059 The snmpd Subsystem has been started. Subsystem PID is 188598.
# lssrc -s snmpd
Subsystem         Group            PID          Status
snmpd            tcpip            188598       active
# exit
$

The CIM server (cimserver) is subsequently started when IVM server is 
rebooted. VIO server provides the lsnetsvc cimserver command to check 
whether the cimserver is running. You can also manually start the CIM server by 
typing the ioscli startnetsvc cimserver command, as shown in Example 3-5.

Example 3-5   Checking, stopping, and starting the cimserver on VIO server

$ lsnetsvc cimserver
Network service "cimserver" is not active.
$ ioscli startnetsvc cimserver
$ lsnetsvc cimserver
root  368716 1056974   0 17:31:54      -  0:00 
/opt/freeware/cimom/pegasus/bin/cimservera
$

You can force cimserver to stop by using the ioscli stopnetsvc cimserver 
command as well.

Note: Make sure that the cimserver is not active before you manually try to 
start it. If active, stop it before trying to restart it manually.

Note: In IVM server, the CIM server is integrated with one of the IVM 
components (ios.lparmgr.cim.rte), therefore you should be careful if you 
re-install or de-install the CIM server.
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Discovering IVM server as a managed object
To establish the communication between IVM server and IBM Director Server, 
you should register IVM server into the managed objects group in IBM Director 
Server. There are two ways to add a managed object:

� Automatic discovery of IVM server
� Manually adding the IVM server

When the IVM server is discovered as a managed object, its IP address is stored 
into the IBM Director database. We recommend that you manually add the IVM 
server to the IBM Director’s managed objects repository. 

Before the manual procedure, you should start IBM Director Console using the 
/opt/ibm/director/bin/twgcon command and log in to the IBM Director Server.

If you have more than one IBM Director Server in your network environment, you 
can access another management server by typing the IP address (or host name) 
in the IBM Director Server login window. See Figure 3-15.

Figure 3-15   Logging in to IBM Director Server

The steps to add the IVM server to managed objects in IBM Director are:

1. In the IBM Director Console menu, click Console → New → Managed 
Objects → Systems. See Figure 3-16.

Note: As we discuss only the manual procedure here, if you want your IVM 
server to be automatically discovered by the IBM Director Server, refer to the 
section “Discovering managed objects” of Chapter 4, “Managing systems” in 
IBM Director Systems Management Guide Version 5.20.
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Figure 3-16   Navigating to Add a new system menu

2. In the Add Systems window, specify values for the System Name, Network 
Protocol, and Network Address fields, and click the OK button. When IBM 
Director finds an IVM server, you will see the complete message as shown in 
Figure 3-17. To verify the IVM server information, you have to click Level 0 : 
Agentless Systems in the Groups panel of IBM Director Console. If you 
cannot see it in central panel, click All Managed Objects in the Groups panel 
on the left.
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Figure 3-17   Typing the IVM server information to add

3. Right-click the IVM server and click Request Access. When you provide the 
correct credentials for the SSH daemon in the IVM server, the managed 
object is unlocked, as shown in Figure 3-18.

Figure 3-18   Unlocking the IVM server (Request Access)

If you upgrade to VIOS 1.3 or later from a previous VIOS version using a fix pack, 
and you have already manually installed OpenSSH, then the 
/etc/ssh/sshd_config file will not be updated. If the file is not updated, the 
non-interactive SSH sessions will not be allowed. In order to force the update, 
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run the ioscli startnetsvc ssh command. If the OpenSSH was not installed 
previously, everything should work without any manual intervention.

Adding an IVM-managed LPAR manually
There is no difference between the IVM server itself and the IVM-managed 
LPARs for the steps to add managed objects to IBM Director Server. You can 
refer to the previous section, “Discovering IVM server as a managed object” on 
page 58, for the steps to add a LPAR that is managed by IVM. 

Launching IBM Integrated Virtualization Manager
One of the brand-new features of IBM Director 5.20 is to launch the 
IBM Integrated Virtualization Manager through IBM Director Console.

1. Click Platform Managers and Members in the left panel of IBM Director 
Console to go to the managed object on which IVM is installed. Then you can 
see that object on the central panel.

2. Right-click the IVM installed object and click Web Browser to launch the IVM 
Web-based GUI. See Figure 3-19.

Figure 3-19   Launching IVM using IBM Director Console

 

 

 

 

 Chapter 3. Scenarios 61



Power control for managed objects managed by IVM
Power control enablement of IBM Director Server is included as part of the base 
IBM Director Server installation for System p server. You do not have to install 
any specific extension for power control of a System p server managed by IVM.

� Power management for LPARs managed by IVM

IVM provides power control for the LPARs it manages, but does not provide 
power control for the LPAR or the physical system on which it runs itself. After 
access request from IBM Director Server is granted to the IVM, when you 
right-click Power Management, the menu provides the applicable tasks: 
Power On when LPAR is off, and Power Off Now or Restart Now when LPAR 
is on.

� Power management of a host physical System p server

A Flexible Service Processor (FSP) provides out-of-band power management 
for the physical system. To enable power control for the physical system 
managed by IVM, perform the following steps:

a. Click Platform Managers and Members in the Groups panel on the left. 
Go to the central panel and right-click the host physical system on which 
IVM is running. Click Power Management → Request Access.

b. Provide the requested information to authenticate your access to the host 
system FSP, normally which this is the admin user of HMC, and the 
appropriate password. You must authenticate only one time with the host 
system that IVM manages. See Figure 3-20.

c. After authentication is complete, when you right-click Power Management, 
the menu provides Power On or Restart Now/Power Off tasks.

Note: If you cannot start the IVM Web-based GUI, we recommend that you 
check to see if your browser runs. If the browser can be manually started, just 
type the IP address of the IVM server to get the IVM Web-based GUI.
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Figure 3-20   Power control for a host physical system managed by IVM

Virtual I/O Server as managed objects
Usually, VIOS is managed as a Level-0 Agent (agentless) object by IBM Director 
Server. The steps for discovery and configuration of VIOS are similar to IVM, 
therefore you can apply this scenario to a VIOS as well. 

If you want to manage VIOS and IVM with SNMP, the SNMP scenario of this 
IBM Redpaper helps you understand it. Refer to 3.3.1, “Working with SNMP on 
IBM Director” on page 66. The SNMP scenario covers how to add the SNMP 
device and configure SNMP features of IBM Director Server. For details on how 
to use SNMP and agentless systems, see 3.3, “Working with agentless (including 
SNMP) systems”.

3.3  Working with agentless (including SNMP) systems

This section covers the management features provided by IBM Director for 
systems where no IBM Director software is installed. Because most of the 
operating systems installations come with the SNMP software installed (as the 
document is related to systems on POWER platforms, we refer here to AIX and 
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Linux), this section also covers the SNMP installation, configuration, and features 
provided, and how IBM Director can interact with these systems.

The agentless systems are managed through the network services that are 
native to the operating system. These services can be SSH or Windows 
Management Instrumentation (WMI). They are called agentless or Level-0 
managed systems because no IBM Director Agent is installed. 

To manage a system using IBM Director, that system, at a minimum, must 
support the Secure Shell (SSH) or Distributed Component Object Model (DCOM) 
protocol. Level-0 managed systems can be IBM or non-IBM servers, desktop 
computers, workstations, and mobile computers.

IBM Director discovers Level-0 managed systems by verifying the IP addresses 
on your network and scanning the ports of those addresses using the SSH or 
DCOM protocols. The range of IP addresses that are verified is governed by the 
IBM Director discovery preferences that you configure in IBM Director Console. 
By default, IBM Director uses the range of addresses that are in the IP domain of 
the management server.

When a Level-0 managed system is discovered, it is locked by default. You can 
unlock the system by requesting access to it through IBM Director Console. After 
you discover and unlock a Level-0 managed system, you can perform a 
minimum set of tasks on the system:

� Collect inventory that is available from the operating system.

� Install Level 1: Core Services or Level 2: IBM Director Agent by using 
Software Distribution.

� Restart the operating system (Linux only).

� Run command-line programs (only if SSH is present).

The list of agentless managed systems can be obtained by selecting Level 0: 
Agentless Systems from the Groups panel, as shown in Figure 3-21.

Figure 3-21   Listing the agentless systems
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Right-click one of the systems. This shows the general tasks available for it (see 
Figure 3-22), which include collecting and viewing the inventory, viewing the 
event log, and the remote session feature. Some tasks are more general, while 
others are specific to the operating system. For example, we can use the remote 
session to have a console access to the system, and that is possible because the 
system provides the ssh access to it.

Figure 3-22   General tasks for agentless systems

Besides the regular tasks available for the agentless systems, we are interested 
in complementary ways to extend the management features for such systems. 
One solution is to use SNMP features by installing and configuring the SNMP 
daemon on the agentless managed system.

We cover the SNMP configuration and testing steps for AIX and Linux on 
POWER systems. For security reasons, we choose to work with an SNMPv3 
configuration because of the security features it provides: It is a user-based 
authentication, the credentials (user name and password, called securityName 
and authKey in SNMPv3 as specified in RFC 2574) are not sent in clear text as 
with the community names of the previous SNMP versions.
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3.3.1  Working with SNMP on IBM Director

Both AIX and Linux distributions provide SNMP packages that enable 
management and monitoring the system through the SNMP. AIX comes by 
default with the installation of the operating system. Starting with AIX 5.2, the 
SNMPv3 non-encrypted version is installed by default and is started at system 
boot time. Further details about SNMP for AIX can be found in the Network and 
communication management AIX manual, in section “SNMP for network 
management”.

IBM Director can detect and see a system as both an agentless system and 
SNMP device. As Figure 3-23 shows, the same linuxmp4, linuxmp6, linuxmp9 
systems can be found as SNMP devices too. Besides the basic tasks available 
for an agentless system, SNMP provides further options that are available, such 
as the SNMP Browser option.

Figure 3-23   IBM Director options for SNMP devices
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The IBM Director Systems Management Guide manual, section “Managing 
SNMP devices”, describes the information required to correctly discover and set 
up an SNMP device or system that is running an SNMP daemon, and how to 
work with the SNMP Browser component.

Before adding or working with an SNMP system, a profile must exist and be 
associated with the system. If the SNMP agent is up and running, and we do not 
want to wait for IBM Director to detect the system at the next discovery interval, 
we can manually add the system by selecting the SNMP Devices group, 
right-clicking an empty space in the SNMP Devices: SNMP System Object ID 
pane, and selecting New → SNMP Devices (see Figure 3-24).

Figure 3-24   Adding an SNMP device manually

Note: If the system is not automatically detected as an SNMP device, you can 
manually add it and associate the corresponding SNMP profile to it so that 
IBM Director server can collect the available data from the SNMP daemon of 
the system.
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The information required is the name (if the server uses IP name resolution) or IP 
address of the system and a profile if the system runs an SNMPv3 configuration 
or the community name for SNMP v1 or v2c versions. This is the reason we have 
to create an SNMP profile before adding the system or device.

To create an SNMPv3 profile, the menu path is Options → Server 
Preferences → SNMP tab. For our configuration, in the Add Profile window, we 
have used the values shown in Table 3-1.

Table 3-1   The ibmDir user SNMPv3 profile

Our SNMPv3 user (securityName) is ibmDir with the password (authKey) 
dirPassword. We left the encryption fields empty. Now that we have the profile 
created, we can manually add the system to our list of SNMP devices. 
Figure 3-25 shows how we add the linuxmp4 system.

Figure 3-25   Data needed to add an SNMPv3 device

Field name Field value

Profile Name ibmDir_SNMPv3_authNoPriv_profile

User Name ibmDir

Authentication Protocol MD5 - HMAC

Password dirPassword

Confirm Password dirPassword
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IBM Director can discover the SNMP devices automatically. By default, the 
IBM Director server assigns the SNMPv1 configuration with the community name 
public. Considering that the linuxmp4 system was already discovered and 
added, this system runs an SNMP agent configured to work with SNMPv3 
configuration, and we only have to assign the right SNMPv3 profile to it. To do 
this, double-click the system to open the Display System Attributes window, 
select the SNMP Devices tab, choose the SNMPv3 option as the SNMP Version 
and ibmDir_SNMPv3_authNoPriv_profile option for the Profile Name field.

We can use the SNMP Browser task to view and configure the attributes of 
SNMP devices, for example, hubs, routers, or other SNMP-compliant 
management devices. SNMP Browser can also be useful for SNMP-based 
management, troubleshooting, or monitoring the performance of SNMP devices.

The managed system is fully configured from the IBM Director point of view and 
we can start using the SNMP Browser available for it. It can be started by 
dragging the SNMP Browser task onto the system or from the contextual menu 
of the system to select SNMP Browser menu option (see Figure 3-26).
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Figure 3-26   SNMP Browser to query data available on linuxmp4 system

Some of the objects in the subtree are read-only, while others can be changed. 
For example, in Figure 3-26, objects such as sysContact, sysName, and 
sysLocation have a read-write access and they can be changed to reflect specific 
information about the system.

Depending on the SNMP agent capabilities, more information can be extracted 
from the system. On linuxmp4 system, which is our target system to explore, the 
agent also provides further information related to hardware and software 
components known by the operating system. The data about the host system 
that an SNMP agent can provide is defined in the industry standard Host 
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Resources Management Information Base (MIB) document, proposed standard 
RFC 1514. 

The Host Resources MIB supported by the SNMP agent provides information 
about the following components:

� Hardware components (in the hrDevice group, we can get data related to 
CPU, memory, disks, and other devices detected by the operating system, 
disk partitions and file systems attributes).

� Software components (the hrSWInstalled group contains detailed information 
about the software installed).

� Various statistics related to the currently running system resources (most of 
them are available in the hrSWRun and hrSWRunPerf groups). Additionally, 
the hrSystem group provides access to data such as the number of user 
sessions and processes currently running.

This is the kind of information that can be extracted from an SNMP agent. Each 
SNMP implementation supports multiple MIB files and therefore further data can 
be provided to the IBM Director Server in the form of classical or informational 
SNMP traps (see Figure 3-27).

Figure 3-27   Sample statistics extracted using SNMP Browser
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3.3.2  SNMP messages to IBM Director

The SNMP agents can send informational or alert messages in the form of traps 
to IBM Director. Like the managed systems running an IBM Director Agent, the 
agentless SNMP systems can send messages to IBM Director Server, and 
depending on the type and information some events can be triggered, the main 
objective being able to proactively monitor the system and minimize the response 
time to problems or possible problems that might affect the system.

Both AIX SNMP and Net-SNMP implementations can be further configured to 
send message with possible problems that might appear such as, for example, 
when one of the file system has only 5% free space left. The SNMP agents can 
monitor and send valuable information to IBM Director and the system 
administrator has time to solve the issue before it becomes a major problem.

For the HMC-managed environments, any LPAR system running on a server 
managed by an HMC system can report events. These are the serviceable 
events that we can work with from the Service Focal Point component of HMC.

Refer to 3.1, “Hardware Management Console managed environment” on 
page 42, for information about configuring the HMC system to send messages to 
IBM Director.

3.4  Using Software Distribution

One of the major tasks of systems management is to control the state of installed 
software on the systems. This task includes operations such as collecting 
information, installing new applications, upgrading old versions, and uninstalling 
deprecated or unused software. 

This task is implemented within IBM Director; it is called Software Distribution.

In this scenario, we detail several practical examples based on Software 
Distribution. The objective is to make you more familiar with the IBM Director 
capabilities regarding this task, focusing on System p management.
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3.4.1  Architecture

For this scenario, we have used the architecture shown in Figure 3-28.

Figure 3-28   Software Distribution environment

It includes:

� IBM Director Server 5.20 on AIX 5.3, where we installed the Software 
Distribution Premium Edition

� AIX 5.3 managed system agentless, where we deployed the IBM Director 
Agent

� AIX 5.3 managed system agent Level-2, where we deployed RPMs

� Any others managed systems to create a dynamic group for patch 
management

Attention: The results of Software Distribution greatly depend on network 
reliability and bandwidth. Software Distribution can cause high usage of 
network bandwidth and, thus, reduce the efficiency of the network to other 
processes. These issues must be carefully considered when defining 
distribution time and parameters.
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3.4.2  Implementation

Software Distribution allows users to import applications and data, build a 
software package, and distribute the package to IBM Director managed systems. 
This includes Level-0, Level-1, and Level-2 Agents.

There are two editions of Software Distribution: standard and premium. With the 
standard edition, customers can only import software distributed by IBM and 
build a software package using the Director Update Assistant wizard. With the 
premium edition, they can largely extend the capabilities of the tool up to the 
creation of fully customized packages.

Three logical steps are required to distribute software to the managed systems 
through this tool:

1. Obtain the software to be distributed.

2. Import the software into IBM Director Server and build a software package.

3. Distribute the software package to managed systems either by streaming 
from the management server to selected managed systems or by using 
redirected distribution.

By default, Software Distribution uses TCP. If you disable TCP-session support 
on a managed system, Software Distribution uses UDP.

In the following section, we provide detailed examples on both versions of the 
Software Distribution task in IBM Director:

� Software Distribution Standard Edition
� Software Distribution Premium Edition

3.4.3  Software Distribution (Standard Edition)

You can use the Software Distribution (Standard Edition) task to import 
applications and data, build a software package, and distribute the package to 
IBM Director managed systems. With IBM Director Software Distribution 
(Standard Edition), you can import only software that is distributed by IBM (such 
as UpdateXpress packages) and build a software package using only the 
IBM Update Assistant wizard.
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Solution Install packages enable software distribution to Level-0, Level-1, and 
Level-2 managed systems. Solution Install packages contain the following elements:

� Installable unit (IU) of software that is self-extracting, self-installing, and runs 
in silent, unattended mode.

� Installable unit deployment descriptor (IUDD) Extensible Markup Language 
(XML) file, the PackagedIU.xml file that describes the dependencies of the 
package.

� Artifact XML file that describes the installation instructions for the IU.

A Solution Install package can be in the form of a JAR file, a .zip file, or a 
Solution Install formatted directory structure.

The XML specification file contains information about the software installation 
package such as version and source file. The cimv20.dtd and IBMupdate.xsl can 
be found on the ftp.software.ibm.com Web site:

� cimv20.dtd

ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers/cimv20.dtd

� IBMupdate.xsl

ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers/IBMupdate.xsl

The packaging format used is the Solution Install (SI) format, and is also 
supported by the AIX 5.3 geninstall command. The SI format is based on the IU 
concept, which is a software entity that can be deployed to an IT system. The 
solution installation architecture defines a root IU as the smallest unit of 
packaging. More information about the SI format can be found in the following 
Web site:

http://www.ibm.com/developerworks/autonomic/

The IBM Directory XML schema IBMPSG_SystemUpdateProduct inherits from 
CIM classes, such as the CIM_Configuration and CIM_SoftwareElement. More 
information about the CIM schemas can be found in the following Web sites:

� Installable Unit Deployment Descriptor Specification Version 1.0

http://www.w3.org/Submission/InstallableUnit-DD/

� CIM Schema: Version 2.8.2 (Final)

http://www.dmtf.org/standards/cim/cim_schema_v28

� The Open Group

http://wiki.opengroup.org/

� OASIS

http://www.oasis-open.org/
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Software distribution and installation flow
You must perform three steps to distribute software packages to IBM Director 
managed systems: 

1. Obtain the software.

2. Import the software into IBM Director Server and build a software package.

3. Distribute and install the software package to managed systems.

Software specification files for distribution and installation from IBM Director 
should be in the XML format.

You import the XML files into IBM Director, and the IBM Update Assistant 
creates software packages. Then, you can use the IBM Director Software 
Distribution task to distribute the packages to the managed systems.

The IBM Update Assistant is a wizard that imports software that is distributed by 
IBM into IBM Director and creates the software package or packages for 
distribution.

The following detailed steps show you how to distribute and install software from 
the IBM Director Server system to a system with the IBM Director Agent:

1. Store BFF or RPM filesets and software installation packages in a file system 
directory on the IBM Director Server system. This can be done with the 
bffcreate command.

2. Create the XML software specification files for all BFF or RPM filesets to 
install.

3. Import the XML software specification files into IBM Director database, using 
the IBM Update Assistant from the IBM Director Console. To do this, select 
Tasks → Software Distribution → Import Software Distribution 
Packages from the IBM Director Console menu. Select Wizards → IBM 
Update Assistant. Select the XML file that was created under the previous 
step 2 above, and select Next and then Finish. If the XML is correct, the 
package specification will be updated under the Tasks column and Software 
Distribution → All Software Distribution Packages.

4. Install the BFF or RPM filesets on the IBM Director Agent system, using the 
Tasks column in the IBM Director Console. To do this, select Software 
Distribution → All Software Distribution Packages → PACKAGE in the 
IBM Director Console Tasks column, where PACKAGE is the imported 

Note: Pay attention to documentation found on the Internet and differentiate 
between the IBM Director (Monitoring and Management Server) and Tivoli 
Director (LDAP server).
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specification for the BFF or RPM fileset to install. Drag this package from the 
Tasks column to the target system in the All Managed Objects column (by 
default or after selecting All Managed Objects from the Groups column). 
Follow the panel instructions to perform the installation or schedule it for later 
(see Figure 3-29).

Figure 3-29   Confirm installation job created from drag-and-drop operation

By selecting Schedule, you can select the installation to be performed at a 
specific date and time. In our example, we select Execute Now and the window 
shown in Figure 3-30 is displayed, and the progress of the submitted task can be 
viewed.
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Figure 3-30   Execution history for installation task

By selecting File → View Log, the following detailed progress report is displayed 
in a new window. By default, the level of information is less than can be shown 
when selecting View → Detail → High as can be seen in Figure 3-31.

Figure 3-31   Execution log for installation task
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Debugging the installation
To debug the IBM Director Agent during the installation process, perform the 
following steps:

1. Stop the IBM Director Agent.
2. Edit the IBM Director Agent TWGRas.properties configuration file.
3. Start the IBM Director Agent again.
4. View the logfiles in /opt/ibm/director/bin/ using the ras* commands.

You can stop the IBM Director Agent with the /opt/ibm/director/bin/twgstop 
command, as shown in Example 3-6.

Example 3-6   Stopping the IBM Director Agent on AIX

root@PSMF80:/: /opt/ibm/director/bin/twgstop
Waiting for service to end.
Service ended.

Edit and save the IBM Director Agent /opt/ibm/director/data/TWGRas.properties 
configuration file and remove all number signs (#), and set the value for 
twg.ras.comps to “262144” to debug only the software distribution part, and set it 
to “-1” to debug everything.

Start the IBM Director Agent again with the opt/ibm/director/bin/twgstart 
command, as shown in Example 3-7.

Example 3-7   Starting the IBM Director Agent on AIX

root@PSMF80:/: /opt/ibm/director/bin/twgstart
Service started.

The twgstart program checks the existence of the /opt/ibm/director/version.srv 
file and, if it is not readable, the twgagent program is started.

Monitor the installation process by viewing the /opt/ibm/director/log/TWGRas.log 
on the IBM Director Server using the rasview, raswatch, or rasdump commands.

The rasdump command (Example 3-8) formats the specified debug log into a 
displayable form. The output can either be displayed to standard output or piped 
to a text file. In Example 3-8, we use plain authentication and not encrypted, 
hence the error messages at startup.

Example 3-8   Using rasdump

root@PSMF80:/: cd /opt/ibm/director/log
root@PSMF80:/opt/ibm/director/log: ../bin/rasdump
18.01.42.441 -- Trace log TWGServer (TWGVersion 5.10 2006-01-20 build id 38) os.name="AIX"
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18.03.26.700 !! TWGServer TWGExtension.LateLaunch()
18.04.33.150 !! TCPIP sender TWGIPCXferSend failed to send DGRAM_SIMPLE_SEND to 
172.16.52.19 for xfer 3. key=1405735931 TWGDatagram.SendEncryptedDatagram:  Creating 
or encrypting send data packet failed to TCPIP::172.16.52.19
18.04.33.169 !! TCPIP sender TWGIPCXferSend failed to send DGRAM_SIMPLE_SEND to 
172.16.52.19 for xfer 4. key=1405735931 TWGDatagram.SendEncryptedDatagram:  Creating 
or encrypting send data packet failed to TCPIP::172.16.52.19
18.04.38.839 !! TCPIP sender TWGIPCXferSend failed to send DGRAM_SIMPLE_SEND to 
172.16.52.19 for xfer 2. key=1405735931 TWGDatagram.SendEncryptedDatagram:  Creating 
or encrypting send data packet failed to TCPIP::172.16.52.19
. . .

The rasview command (Example 3-9) and the raswatch command format the 
debug information in real time in the standard output stream of the current shell. 
Functionally, these commands are the same; however, raswatch contains a 
check that it does not start unless the IBM Director service is already active.

Example 3-9   Using rasview

root@PSMF80:/: cd /opt/ibm/director/log
root@PSMF80:/opt/ibm/director/log: ../bin/rasview -high -mask=262144
Viewing log for all components
. . .
2006-12-05 18.05.52.306 !! Thread-92 pegcli     at 
com.tivoli.twg.engine.TWGNatveManagedObject$SubscriptionThread.run(TWGNativeManagedOb
ject.java:5750)
. . .
2006-12-05 18.08.20.974 !! ServiceNode <TicUnixAgent> pegcli    at 
com.tivoli.twg.inventory.agent.unix.TicUnixInventory.GetTables(TicUnixInventory.java:
171)
2006-12-05 18.08.20.974 !! ServiceNode <TicUnixAgent> pegcli    at com.tivoli.tw
g.inventory.agent.unix.TicUnixInventory.CommandReceived(TicUnixInventory.java:118)
. . .

Creating the installation package
The installation package should consist of two files, one XML specification file 
and one self-installing file.

Creating the self-installing file
The IBM Director usually only transfers one package file to be installed. It is then 
up to this package file to perform whatever operations it wants to update or install 
software on the IBM Director managed node, in this case, an IBM Director Agent 
node.
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The self-installing file is first transferred by the IBM Director Server and then it is 
executed on the IBM Director Agent.

The method used by the default upgrade package for the IBM Director Agent is a 
form of SHAR-archive (SHell ARchiving utility). 

The files in a shell archive are concatenated without compression, and the 
resultant archive is essentially a shell script, complete with #!/bin/sh header (or 
other “shebang”), and containing all the necessary unarchiving and installation 
commands.

The file package can be a executable binary or even a normal shell script. The 
shell script can invoke Network Installation Manager (NIM) to perform installation 
of the software or can perform Network File System (NFS) mounts and use 
installp or rpm install commands to install specific software from a remote 
server.

The following simple script installs the bos.adt fileset on the NIM client LPAR66, 
from the NIM master named MASTER, using the NIM lpp_source LPP530. The 
c_sm_nim_cust script is a SMIT installation script that uses the nimclient 
command. The script is named Hello and can be executed from the command 
line with ksh -xvn Hello for verification (see Example 3-10).

Example 3-10   Example IBM Director installation package script “Hello” with nimclient commands

#!/usr/bin/ksh
niminit -aname=LPAR66 -apif_name=en0 -amaster=MASTER -aplatform=chrp -acable_type1=”N/A”
/usr/lpp/bos.sysmgt/nim/methods/c_sm_nim cust  -l LPP530 \
-o 'bos.adt ALL @@I:bos.adt _all_filesets' -f Y -f g -f X

The nimclient command can be used to install software bundles of BFF or RPM 
filesets from the NIM master to the NIM client or clients, which are also 
IBM Director managed systems.

Attention: Do not edit the script with a Microsoft Windows editor, or 
something similar, that adds a Carriage Return (CR) character after each line 
in addition to the Line Feed (LF) character. For UNIX® and AIX, each line 
should be terminated with only the LF character. If there is a CR character at 
the end of the script lines, the script will not be executed by the IBM Director 
Agent after it is transferred and the task will be incomplete.

Note: The error message “0042-041 niminit: /etc/niminfo already 
exists” is not important; it only warns that the client system is already a NIM 
client.
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Creating the XML specification file
The following sample XML uses a script (doinstallp) to install the AIX 5.3 
content list fileset. The doinstallp script is just a simple korn shell script using 
the installp command. To view the XML file using the XSL translation, just open 
the XML file in a Web browser, provided the cimv20.dtd and IBMupdate.xsl files 
are in the same directory. In the XML in Example 3-11, the script name is Hello 
and the package is named Hello.

Example 3-11   Sample XML specification file for IBM Director Software Distribution package

<?xml version="1.0" encoding="ISO-8859-1" ?>
<!DOCTYPE CIM SYSTEM "cimv20.dtd">
<?xml-stylesheet type="text/xsl" href="IBMupdate.xsl" ?>
<CIM CIMVERSION="2.0" DTDVERSION="2.0">
 <MESSAGE ID="1" PROTOCOLVERSION="1.0">
 <MULTIREQ>
  <SIMPLEREQ>
   <IMETHODCALL NAME="CreateInstance">
    <LOCALNAMESPACEPATH>
     <NAMESPACE NAME="root"/>
     <NAMESPACE NAME="cimv2"/>
    </LOCALNAMESPACEPATH>
    <IPARAMVALUE NAME="NewInstance">
     <INSTANCE CLASSNAME="IBMPSG_SystemUpdateProduct">
      <PROPERTY NAME="Name" TYPE="string"><VALUE>Hello</VALUE></PROPERTY>
      <PROPERTY NAME="IdentifyingNumber" 
TYPE="string"><VALUE>999999999</VALUE></PROPERTY>
      <PROPERTY NAME="Version" TYPE="string"><VALUE>1.0</VALUE></PROPERTY>
      <PROPERTY NAME="ibmSchemaVersion" TYPE="string"><VALUE>1.0</VALUE></PROPERTY>
     </INSTANCE>
    </IPARAMVALUE>
   </IMETHODCALL>
  </SIMPLEREQ>

  <SIMPLEREQ>
   <IMETHODCALL NAME="CreateInstance">
    <LOCALNAMESPACEPATH>
     <NAMESPACE NAME="root"/>
     <NAMESPACE NAME="cimv2"/>
    </LOCALNAMESPACEPATH>
    <IPARAMVALUE NAME="NewInstance">
     <INSTANCE CLASSNAME="IBMPSG_SystemUpdateElement">
<PROPERTY NAME="Name" TYPE="string"><VALUE>Hello</VALUE></PROPERTY>
<PROPERTY NAME="SoftwareElementID" TYPE="string"><VALUE>ABCDEF</VALUE></PROPERTY>
<PROPERTY NAME="SoftwareElementState" TYPE="uint16"><VALUE>1</VALUE></PROPERTY>
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<PROPERTY NAME="TargetOperatingSystem" TYPE="uint16"><VALUE>9</VALUE></PROPERTY>
<PROPERTY NAME="type" TYPE="uint16"><VALUE>4</VALUE></PROPERTY>
<PROPERTY NAME="Version" TYPE="string"><VALUE>Version 1.0</VALUE></PROPERTY>
<PROPERTY.ARRAY NAME="applicableMachineTypes" TYPE="string"><VALUE.ARRAY>
    <VALUE>IBM Director Agent Install</VALUE>
 </VALUE.ARRAY></PROPERTY.ARRAY>
<PROPERTY.ARRAY NAME="applicableOperatingSystems" TYPE="string"><VALUE.ARRAY>
    <VALUE>AIX 5L Version 5.2</VALUE>
    <VALUE>AIX 5L Version 5.3</VALUE>
</VALUE.ARRAY></PROPERTY.ARRAY>
<PROPERTY.ARRAY NAME="architecture" TYPE="string"><VALUE.ARRAY>
    <VALUE>POWERPC</VALUE>
</VALUE.ARRAY></PROPERTY.ARRAY>
<PROPERTY NAME="buildNumber" TYPE="string"><VALUE>WBYT21AUS</VALUE></PROPERTY>
<PROPERTY NAME="description" TYPE="string"><VALUE>This package installs 
Hello.</VALUE></PROPERTY>
<PROPERTY NAME="installCommandLine" TYPE="string"><VALUE></VALUE></PROPERTY>
<PROPERTY NAME="installationNotes" TYPE="string"><VALUE>This is a NIM installation 
script.</VALUE></PROPERTY>
<PROPERTY NAME="languageEdition" TYPE="string"><VALUE>All</VALUE></PROPERTY>
<PROPERTY NAME="manufacturer" TYPE="string"><VALUE>IBM</VALUE></PROPERTY>
<PROPERTY NAME="rebootRequired" TYPE="uint8"><VALUE>0</VALUE></PROPERTY>
<PROPERTY NAME="regions" TYPE="string"><VALUE>Worldwide</VALUE></PROPERTY>
<PROPERTY NAME="releaseDate" 
TYPE="datetime"><VALUE>2006-04-15T14:36:11Z</VALUE></PROPERTY>
<PROPERTY NAME="revisionHistory" TYPE="string"><VALUE>1.0 Modified 
2006-04-15T14:36:11Z.</VALUE></PROPERTY>
<PROPERTY NAME="severity" TYPE="uint8"><VALUE>99</VALUE></PROPERTY>
<PROPERTY NAME="installDirectory" TYPE="string"><VALUE>./FILES</VALUE></PROPERTY>
<PROPERTY NAME="unattendedInstallCommandLine" 
TYPE="string"><VALUE>./Hello</VALUE></PROPERTY>
<PROPERTY NAME="unattendedUninstallCommandLine" 
TYPE="string"><VALUE></VALUE></PROPERTY>
<PROPERTY NAME="uninstallCommandLine" TYPE="string"><VALUE></VALUE></PROPERTY>
     </INSTANCE>
    </IPARAMVALUE>
   </IMETHODCALL>
  </SIMPLEREQ>
 </MULTIREQ>
 </MESSAGE>
</CIM>
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Some of the CIM and IBMPGS XML properties are:

Name The name used to identify this software element

softwareElementState CIM-derived attribute identifies the installation state of 
software; valid values are: 0=Deployable, 1 = Installable, 
2 = Executable, 3 = Running

softwareElementID CIM-derived attribute used as an identifier for this 
software element that can be used as a unique identifier 
when the Name attribute value is insufficient

identifyingNumber CIM-derived attribute for product identification such as a 
serial number

manufacturer CIM-derived attribute identifying the software 
manufacturer 

languageEdition The language edition of this software element; the 
language codes defined in ISO 639 should be used

Version CIM-derived attribute for version and release; version 
should be in the form <Major>.<Minor>.<Revision> or 
<Major>.<Minor><letter><revision>

TargetOperatingSystem

The target operating system environment. Two other 
pieces of information are required. First, the version of 
the operating system (OS) has to be specified, using the 
OS Version Check. The second piece of information is 
the architecture that the OS runs on. This information is 
captured with the ArchitectureCheck class. The 
combination of these constructs allows the provider to 
clearly identify the level of OS required for a particular 
software element.

rebootRequired If rebootRequired is set (1), the installation expects that 
the IBM Director Agent will be restarted, not the system.

installDirectory The installDirectory property specifies the directory on the 
IBM Director Server where the package in the 
unattendedInstallCommandLine can be found.

unattendedInstallCommandLine

The unattendedInstallCommandLine is the file name and 
file system path, relative to the value of installDirectory 
property.
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3.4.4  Software Distribution (Premium Edition)

You can use the Software Distribution (Premium Edition) task to import 
applications and data, build a software package, and distribute the package to 
IBM Director managed systems.

In addition to the functions provided by IBM Director Software Distribution 
(Standard Edition), Software Distribution (Premium Edition) has several 
additional capabilities.

For AIX on System p and Linux, you can import software or build software 
packages with the following wizards: 

� AIX InstallP wizard (AIX) 
� RPM Package wizard (AIX and Linux) 

The principles for both wizards are the same, therefore we only show the steps 
with the AIX InstallP wizard.

AIX InstallP wizard
Using the AIX InstallP wizard is much more easy and simpler for installing BFF 
filesets on AIX systems. This is the preferred way to use for installing BFF 
filesets with IBM Director to managed AIX systems.

The steps to distribute and install software from the IBM Director Server system 
to a system with IBM Director Agent installed are:

1. Store BFF or RPM filesets and software installation packages in a file system 
directory on the IBM Director Server system. This can be done with the 
bffcreate command.

2. Create a Software Distribution package. To do this, select Tasks → Software 
Distribution → Import Software Distribution Packages from the 
IBM Director Console menu. Select Wizards → AIX InstallP Package or 
Wizards → RPM Package, depending on the fileset format. Name the 
package and select Next. Add filesets to the package by clicking Add and 
then select the required filesets. Then select Finish and the package is 
created.

3. Install the BFF or RPM filesets on the IBM Director Agent system, using the 
Tasks column in the IBM Director Console. To do this, select Software 
Distribution → All Software Distribution Packages → PACKAGE in the 
IBM Director Console Tasks column, where PACKAGE is the created 
package to install. Drag this package from the Tasks column to the target 
system in the All Managed Objects column (by default or after selecting All 
Managed Objects from the Groups column). Follow the panel instructions to 
perform the installation or schedule it for later.
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Figure 3-32 shows the status of the installation, from “In progress” to “Complete”.

Figure 3-32   Submitted installation task
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Appendix A. Configuring SNMPv3 for AIX 
and Linux for POWER

In this appendix, we provide the configuration steps performed in order to have a 
secure SNMPv3 configuration ready to be used. The targets for our two 
configuration examples are an AIX v5.3 system and a Linux SUSE Linux 
Enterprise Server 10 (SLES 10) system. 

There are different Simple Network Management Protocol (SNMP) 
implementations available for AIX and Linux. For the AIX system, we use the 
native SNMP implementation that comes by default with the operating system, 
and for the Linux system we use the Net-SNMP agent implementation.

A
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A.1  AIX SNMPv3 configuration
The SNMP agent that is installed by default with the AIX operating system is part 
of the bos.net.tcp.server fileset. This fileset includes the SNMP agent, the SNMP 
DPI2 subagents, and the snmpinfo program used for getting the setting data in 
SNMP objects that the agent provides.

In AIX, the SNMP agent (snmpd daemon) and the three hostmibd, snmpmibd, 
aixmibd DPI2 subagents are started at boot time from the /etc/rc.tcpip file as 
subsystems. At run time, the status can be obtained using the lssrc utility to 
query the SRC master, as shown in Example A-1.

Example: A-1   Using the lssrc utility to query the SRC master

# lssrc -g tcpip | egrep "snmp|mib"
 snmpd            tcpip            192606       active
 hostmibd         tcpip            196704       active
 snmpmibd         tcpip            90286        active
 aixmibd          tcpip            155732       active
# 

In terms of security, SNMPv3 provides authentication and privacy services. The 
authentication is not based on a community name that is sent in clear text in the 
datagram from the SNMP manager to the agent. The SNMPv1 and SNMPv2c 
versions are community-based. The SNMPv3 specification adds the security 
features that the previous versions lacked. The second security feature, called 
privacy, offers the encryption of the messages in the client agent 
communication. 

The SNMPv3 architecture introduces the User-based Security Model (USM) for 
message security and the View-based Access Control Model (VACM) for access 
control. USM uses the concept of a user for which security parameters (levels of 
security, authentication and privacy protocols, and keys) are configured at both 
the agent and the manager. The use of VACM involves defining collections of 
data (called views), groups of users of the data, and access statements that 
define which views a particular group of users can use for reading, writing, or 
receipt in a trap.

This configuration covers the USM and VACM part of SNMPv3 configuration. In 
terms of USM data, this means that we have to provide information about the 

Note: To use the SNMPv3 privacy features, the SNMP encrypted version has 
to be installed. This version can be found in the AIX Expansion Pack.
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user (securityName, authProto, authKey). The VACM part contains the 
mappings between the user, group, data, and type of access granted.

We do not have to restrict the access of our user to any data. We just create the 
user, named ibmDir, who will be used by the IBM Director Server to access (read 
access, write access where possible) the data provided by the SNMP agent.

The snmpd daemon uses the /etc/snmpdv3.conf configuration file. This is the 
only file that we work with for configuring the agent.

We start by generating the authentication keys for our user using the pwtokey 
command, as shown in Example A-2.

Example: A-2   Generating the authentication keys using pwtokey

# pwtokey -p HMAC-MD5 -u auth dirPassword virt_p1
Display of 16 byte HMAC-MD5 authKey:
a58285ed4173335c24bdd9ab47c0d69b

Display of 16 byte HMAC-MD5 localized authKey:
e4c1608c220969eca14ea2333fa76edc

#

We update the snmpdv3.conf file to include for the user ibmDir the following 
entries, as shown in Example A-3.

Example: A-3   SNMPv3 configuration for ibmDir user (USM part)

#-------------------------------------------------------------------
# USM_USER entries
#    Defines a user for the User-based Security Model (USM).
# Format is:
# userName engineID authProto authKey privProto privKey keyType storageType
#-------------------------------------------------------------------

USM_USER ibmDir - HMAC-MD5 e4c1608c220969eca14ea2333fa76edc - - L -

Note that we chose the localized authKey from the pwtokey output to be included 
as the authKey of the ibmDir user. As specified in RFC 2574, the localized key is 
a secret key shared between a user and the authoritative SNMP engine. Even 
though a user might have only one password and therefore one key for the whole 
network, the actual secrets shared between the user and each authoritative 
SNMP engine are different. 
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We want our user to have access to any data available. For this case, to have a 
common configuration for both AIX and Linux (configuration of it is described 
later in this document), we choose to provide the ibmDir user access to system, 
interfaces, tcp, and host subtrees. To accomplish this, we update the 
/etc/snmpdv3.conf file on AIX with the following entries, as shown in 
Example A-4.

Example: A-4   SNMPv3 configuration for ibmDir user (VACM part)

#---------------------------------------------------------------------------
# VACM_GROUP entries
#    Defines a security group (made up of users or communities)
#    for the View-based Access Control Model (VACM).
# Format is:
#  groupName securityModel securityName storageType
#---------------------------------------------------------------------------

VACM_GROUP ibmDirGrp USM ibmDir -

#---------------------------------------------------------------------------
# VACM_VIEW entries
#    Defines a particular set of MIB data, called a view, for the
#    View-based Access Control Model.
# Format is:
#  viewName viewSubtree viewMask viewType storageType
#---------------------------------------------------------------------------

VACM_VIEW ibmDirGrpView system - included -
VACM_VIEW ibmDirGrpView host - included -
VACM_VIEW ibmDirGrpView tcp - included -
VACM_VIEW ibmDirGrpView interfaces - included -

#---------------------------------------------------------------------------
# VACM_ACCESS entries
#    Identifies the access permitted to different security groups
#    for the View-based Access Control Model.
# Format is:
#  groupName contextPrefix contextMatch securityLevel securityModel readView 
writeView notifyView storageType
#---------------------------------------------------------------------------

VACM_ACCESS ibmDirGrp - - AuthNoPriv USM ibmDirGrpView ibmDirGrpView 
ibmDirGrpView -

We can now restart the snmpd daemon and do some basic tests to check our 
configuration. The snmpd daemon is a subsystem and can be managed using 
the SRC utilities. To restart the snmp daemon, you can use the stopsrc and 
startsrc commands, as shown in Example A-5.
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Example: A-5   Restarting the SNMP agent on AIX

# stopsrc -s snmpd
0513-044 The snmpd Subsystem was requested to stop.
# startsrc -s snmpd
0513-059 The snmpd Subsystem has been started. Subsystem PID is 446670.
#

A basic verification of the configuration is to request some data to the SNMP 
agent. The basic test can include some read and write operations on the agent. 
The steps can be performed on any other SNMP implementation that is not 
particularly related to AIX environment.

In Example A-6, we do a snmpwalk to browse the system subtree, and we change 
the system location information (available in sysLocation object instance) with 
snmpset and read it again to see the changes using the snmpget command. 

Example: A-6   Basic verification test on the SNMP agent

# snmpwalk -v3 -l authNoPriv -u ibmDir -a MD5 -A dirPassword virt_p1 system
SNMPv2-MIB::sysDescr.0 = STRING: IBM PowerPC CHRP Computer
Machine Type: 0x0800004c Processor id: 00C6627E4C00
Base Operating System Runtime AIX version: 05.03.0000.0050
TCP/IP Client Support version: 05.03.0000.0051
SNMPv2-MIB::sysObjectID.0 = OID: SNMPv2-SMI::enterprises.2.3.1.2.1.1.3
DISMAN-EVENT-MIB::sysUpTimeInstance = Timeticks: (712100) 1:58:41.00
SNMPv2-MIB::sysContact.0 = STRING:
SNMPv2-MIB::sysName.0 = STRING: virt_p1
SNMPv2-MIB::sysLocation.0 = STRING:
SNMPv2-MIB::sysServices.0 = INTEGER: 72
SNMPv2-MIB::sysORLastChange.0 = Timeticks: (600) 0:00:06.00
SNMPv2-MIB::sysORID.1 = OID: SNMPv2-SMI::enterprises.2.3.1.2.1.1.3
SNMPv2-MIB::sysORID.2 = OID: SNMPv2-SMI::enterprises.2.3.1.2.3.1.1
SNMPv2-MIB::sysORID.3 = OID: SNMPv2-SMI::enterprises.2.6.191
SNMPv2-MIB::sysORID.4 = OID: SNMPv2-SMI::enterprises.2.3.1.2.1.6
SNMPv2-MIB::sysORID.5 = OID: HOST-RESOURCES-MIB::host
SNMPv2-MIB::sysORDescr.1 = STRING: AIX SNMP Agent
SNMPv2-MIB::sysORDescr.2 = STRING: SMUX ATM daemon
SNMPv2-MIB::sysORDescr.3 = STRING: AIX Enterprise MIB Support subagent
SNMPv2-MIB::sysORDescr.4 = STRING: AIX SNMP MIB SubAgent
SNMPv2-MIB::sysORDescr.5 = STRING: Host Resources DPI sub-agent Version 1

... (content omitted) ...

# snmpget -v3 -l authNoPriv -u ibmDir -a MD5 -A dirPassword virt_p1 sysLocation.0
SNMPv2-MIB::sysLocation.0 = STRING:
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# snmpset -v3 -l authNoPriv -u ibmDir -a MD5 -A dirPassword virt_p1 
sysLocation.0 s 'DataRoom2,Floor 1'

# snmpget -v3 -l authNoPriv -u ibmDir -a MD5 -A dirPassword virt_p1 sysLocation.0
SNMPv2-MIB::sysLocation.0 = STRING: DataRoom2,Floor 1

The read and write operations work, therefore we consider our configuration and 
test for the SNMPv3 agent on AIX completed. 

After the managed system is added to the IBM Director Server, using the SNMP 
Browser on the same system (named virt_p1), we have access to the 
components that we defined in the VACM configuration part (see Example A-4 
on page 90). See Figure A-1.

Figure A-1   Checking the data provided by the agent using SNMP Browser

The aixmibd SNMP DPI2 subagent collects data from the system for variables 
defined in the AIX enterprise specific Management Information Base (MIB). The 
subagent receives SNMP requests and sends data via the SNMP-DPI API for 
communication with the main AIX snmpd daemon. An Enterprise Management 
application or other simple application (for example, snmpinfo command) uses 
SNMP protocol to get or set AIX MIB objects.

One focus of the aixmibd subagent is on the data related to the file systems, 
volume groups, logical volumes, physical volumes, paging space, processes, 
print queues, print jobs, system users, system groups, users currently logged in, 
subsystems, subservers, system environment, and various devices.
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Another focus of the aixmibd subagent is on important system traps. Traps, which 
are also called indications, or notifications, are event reports and are used to 
decrease the length of time between when the event happens and when it is 
noticed by a manager so that the event can be handled in a timely manner. Traps 
are generated periodically to report the status change and operating status of the 
system.

The aixmibd daemon can be configured for sending informations or alerts to the 
IBM Director Server with valuable information about the status of the different 
components.

More information about configuring the aixmibd subagent can be found in the 
aixmibd manual pages.

A.2  Linux SNMPv3 configuration
This section describes the steps for configuring the SNMPv3 on a Linux system. 
Although we refer in this document to Red Hat and SUSE distributions available 
on POWER platforms and supported by the IBM Director, the actual 
configuration applies to any other Linux system that we might want to have 
configured to send messages to our IBM Director Server.

The information presented covers the Net-SNMP agent that is included in most 
of the Linux distribution, including the Red Hat Enterprise Linux (RHEL) and 
SUSE distributions. We can either install the packages available on the 
distribution kit or to go to:

http://net-snmp.sourceforge.net 

Then download the source code of the latest version, compile it, and install it.

The system we choose for this configuration is the linuxmp4 system, running 
SLES 10. The Net-SNMP implementation for SLES 10 comes with the 
distribution as net-snmp-5.3.0.1-25.2.ppc.rpm package. This package includes 
all the utilities and daemons that we need to start our SNMPv3 configuration from 
scratch.

The Net-SNMP agent has a snmpd.conf configuration file associated. Usually, by 
running a rpm -ql net-snmp on the system to list the files installed by the 
package, we can see that the full path of it is /etc/snmp/snmpd.conf. But there is 
another more useful way to find the places where the agent is looking for the 
configuration files at startup.
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For starting and stopping the agent, the following commands are available:

� For starting the agent, either service snmpd start or /etc/init.d/snmpd 
start commands can be used.

� For stopping the agent, either service snmpd stop or /etc/init.d/snmpd 
stop commands can be used.

Considering that for our distribution and package installed, we do not know the 
location of the persistent data file, the snmpd program can help us by providing 
the path it searches for the snmpd.conf configuration file, by running the following 
command:

snmpd -Dread_config -H 2>&1 | grep "config path" | sort -u

This can have an output similar to the one shown in Example A-7.

Example: A-7   Paths that Net-SNMP agent searches for snmpd.conf file

# snmpd -Dread_config -H 2>&1 | grep "config path" | sort -u
read_config:  config path used for 
agentx:/etc/snmp:/usr/share/snmp:/usr/lib/snmp:/root/.snmp (persistent 
path:/var/lib/net-snmp)
read_config:  config path used for agentx:/var/lib/net-snmp (persistent 
path:/var/lib/net-snmp)
read_config:  config path used for 
snmp:/etc/snmp:/usr/share/snmp:/usr/lib/snmp:/root/.snmp (persistent 
path:/var/lib/net-snmp)
read_config:  config path used for snmp:/var/lib/net-snmp (persistent 
path:/var/lib/net-snmp)
read_config:  config path used for 
snmpd:/etc/snmp:/usr/share/snmp:/usr/lib/snmp:/root/.snmp (persistent 
path:/var/lib/net-snmp)
read_config:  config path used for snmpd:/var/lib/net-snmp (persistent 
path:/var/lib/net-snmp)
#

The snmpd.conf configuration file is /etc/snmp/snmpd.conf. There is also a 
/var/lib/net-snmp/snmpd.conf persistent data file. The persistent data file is the 
place where the agent keeps all the SNMP objects data that can be changed at 
run time (and not defined in /etc/snmp/snmpd.conf file). Usually, we do not have 
to use the persistent data file, because the agent is doing the management of it.

For a simple test to make sure that the SNMP agent works properly, we can 
create a basic configuration by having only the lines shown in Example A-8 in the 
/etc/snmp/snmpd.conf file.
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Example: A-8   Basic configuration file for the agent

syslocation Somewhere
rocommunity public
rwcommunity private

We start or restart the agent and do some read and write operations as shown in 
Example A-9.

Example: A-9   Read and write operations for testing a basic SNMP configuration

# snmpwalk -v1 -c public linuxmp4 system
SNMPv2-MIB::sysDescr.0 = STRING: Linux linuxmp4 2.6.16.21-0.8-ppc64 #1 
SMP Mon Jul 3 18:25:39 UTC 2006 ppc64
SNMPv2-MIB::sysObjectID.0 = OID: NET-SNMP-MIB::netSnmpAgentOIDs.10
DISMAN-EVENT-MIB::sysUpTimeInstance = Timeticks: (1101) 0:00:11.01
SNMPv2-MIB::sysContact.0 = STRING: root@localhost
SNMPv2-MIB::sysName.0 = STRING: linuxmp4
SNMPv2-MIB::sysLocation.0 = STRING: Somewhere
... (content omitted) ...

# snmpget -v2c -c public linuxmp4 sysContact.0
SNMPv2-MIB::sysContact.0 = STRING: root@localhost
#
# snmpset -v2c -c private linuxmp4 sysContact.0 s 'SysAdmin 
admin@system.com'
SNMPv2-MIB::sysContact.0 = STRING: SysAdmin admin@system.com
#
# snmpget -v2c -c public linuxmp4 sysContact.0
SNMPv2-MIB::sysContact.0 = STRING: SysAdmin admin@system.com
#

An example file for snmpd.conf configuration can be found at 
/usr/share/doc/packages/net-snmp/EXAMPLE.conf.

We can now start to create a SNMPv3 configuration. Our target is to have a 
secure SNMPv3 configuration, therefore first of all we delete the two lines 
(starting with the rocommunity and rwcommunity keywords) that specify the 
community names for read-only and read-write operations, as they are related to 
SNMPv1 and SNMPv2 specifications.

We start with the following basic configuration file /etc/snmp/snmpd.conf that 
contains only the following lines:

syslocation  "DataRoom #1"
syscontact  "SysAdmin admin@system.com"
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Before continuing our configuration, we stop the snmp agent using:

service snmp stop

We do this because we have to add some information in the snmpd.conf 
persistent data file and if the agent is running, any change to that file will be 
overwritten at the next stop of the agent.

We create a user named ibmDir with read-write access to everything on the 
SNMP data, by adding the following line to /var/lib/net-snmp/snmpd.conf 
persistent data file:

createUser ibmDir MD5 dirPassword

We specify the read-write granted user by adding the following line in 
/etc/snmp/snmpd.conf configuration file:

rwuser ibmDir auth

The configuration file /etc/snmp/snmpd.conf should contain the following lines:

syslocation "DataRoom #1"
syscontact "SysAdmin admin@system.com"
rwuser ibmDir auth

We start the agent again using:

service snmpd start

We check the agent log file for errors or warnings (if any), as shown in 
Example A-10.

Example: A-10   Checking the SNMP agent log file

# tail -n10 /var/log/net-snmpd.log
NET-SNMP version 5.3.0.1
#

From the output shown in Example A-10, we can see that there is no 
configuration problems. Therefore, we can do the tests again on the 

Note: There are no security issues related to specifying the authentication key 
in clear text as presented above. We included the authKey in the persistent 
data file, but the agent is responsible for managing the content of this file. For 
this reason, after starting the agent again, we can see that our “createUser 
ibmDir ...” line has been changed into another line that starts with “usmUser 
1 3 0x80001f8...”. This is because the agent creates during startup the 
SNMPv3 secret keys used for securing the communication.

 

 

 

 

96 IBM Director on System p5



configuration. Using the same snmpget test as we started, we can see that now 
the agent does not respond anymore because the request is not authorized. That 
is normal behavior: As specified in RFC 2574, the SNMP agent must not respond 
to a request that is not authorized. See the output in Example A-11 for an 
example of this.

Example: A-11   SNMP agent does not respond to an unauthorized request

# snmpwalk -v1 -c public linuxmp4 system
Timeout: No Response from linuxmp4
#

But the agent responds to a right SNMPv3 request, as shown in Example A-12.

Example: A-12   Authorized SNMP requests get the response from the agent

# snmpget -v3 -l authNoPriv -u ibmDir -a MD5 -A dirPassword linuxmp4 
sysLocation.0
SNMPv2-MIB::sysLocation.0 = STRING: "DataRoom #1"
#

At this point, we have finished configuring the USM component of the SNMPv3 
security. The Net-SNMP agent is not sensitive if the VACM configuration is not 
included (as the AIX implementation is). If we have to put some restrictions on 
the data that ibmDir has to access, then the VACM information must be included 
in the configuration file. We can manage the users using the snmpusm program 
that comes with the Net-SNMP package. snmpusm is meant to ease the 
administration of SNMPv3 users.

The system is ready to be managed as an SNMP device from the IBM Director 
point of view.
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acronyms
AIX Advanced Interactive 
Executive

APAR Authorized Program Analysis 
Report

API Application Programming 
Interface

ATM Asynchronous Transfer Mode

BFF Backup File Format

CEC Central Electronic Complex

CHRP Common Hardware 
Reference Platform

CIM Common Information Model

CIMOM CIM Object manager

CPU Central Processing Unit

CSM Cluster Systems 
Management

DCOM Distributed Component 
Object Model

DHCP Dynamic Host Configuration 
Program

DLPAR Dynamic LPAR

FSP Frame Service Processor

GUI Graphical User Interface

HACMP High-Availability Cluster 
Multi-Processing

HMC Hardware management 
Console

HPC High Performance Computing

IBM International Business 
Machines Corporation

ITSO International Technical 
Support Organization

IVM Integrated Virtualization 
Manager

LPAR Logical Partition

Abbreviations and  
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MIB Management Information 
Base

NFS Network File System

NIM Network Installation manager

OID Object ID

PID Process ID

POWER Performance Oprimization 
With Enhanced RISC

PXE Preboot Execution 
Environment

RDM Remote Deployment manager

RFC Request For Comment

RISC Reduced Instruction Set 
Computer

RSA Rivest Shamir and Adelman

SDPE Software Distribution 
Premium Edition

SLP Service Location Protocol

SMIT System management 
Interface Tool

SMP Symmetric Multi-Processing

SMS System Management 
Services

SNMP Simple Network Management 
Protocol

SRC System Resource Controller

SSH Secure Shell

SSL Secure Socket Layer

UDB Universal Database

UDP Universal Datgram Protocol

UIM User Interface manager

USM Unified Service Management

VIO Virtrual I/O

VIOS Virtual I/O Server
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XML Extended Markup Language
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Related publications

The publications listed in this section are considered particularly suitable for a 
more detailed discussion of the topics covered in this Redpaper.

IBM Redbooks
For information about ordering these publications, see “How to get IBM 
Redbooks” on page 103. Note that some of the documents referenced here may 
be available in softcopy only. 

� Integrating IBM Director with Enterprise Management Solutions, SG24-5388

� Implementing IBM Director 5.20, SG24-6188

� Integrated Virtualization Manager on IBM System p5, REDP-4061

� Using the IBM Director cimsubscribe Utility, REDP-4123

Other publications
These publications are also relevant as further information sources:

� IBM Director product publications

– IBM Director Planning, Installation and Configuration Guide

– IBM Director Systems Management Guide

– IBM Director Troubleshooting and Support Reference

– IBM Director Hardware and Software Support Guide

– IBM Director Commands Reference

– IBM Director Events Reference

– IBM Director Express Planning, Installation and Configuration Guide

– IBM Management Processor Command-line Interface Utility User's Guide
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Online resources
These Web sites are also relevant as further information sources:

� IBM Director home page

http://www-03.ibm.com/systems/management/director/index.html

� IBM Director documentation and resources

http://www.ibm.com/systems/management/director/resources/index.html

� IBM Director product publications

http://www-307.ibm.com/pc/support/site.wss/pageRedirect.do?page=MIGR
-61788

� IBM Director: Extensions - System Availability

http://www-03.ibm.com/servers/eserver/xseries/systems_management/ibm
_director/extensions/sysa.html

� IBM eServer xSeries: Downloads

http://www-03.ibm.com/servers/eserver/xseries/systems_management/xse
ries_sm/dwnl.html

� IBM System p and AIX Information Center

http://publib.boulder.ibm.com/infocenter/pseries/index.jsp

� IBM Director user forum

http://www-128.ibm.com/developerworks/forums/dw_forum.jsp?forum=759&
cat=53

� IBM Cluster information center

http://publib.boulder.ibm.com/infocenter/clresctr/vxrx/index.jsp?top
ic=/com.ibm.cluster.csm.doc/clusterbooks.html

� IBM Service and productivity tools for Linux on POWER

https://www14.software.ibm.com/webapp/set2/sas/f/lopdiags/home.html

� IBM AIX Toolbox for Linux Applications

http://www.ibm.com/servers/aix/products/aixos/linux/download.html

� IBM Support site

http://www.ibm.com/support

� IBM Tivoli Directory Server

http://www-306.ibm.com/software/tivoli/products/directory-server/req
uirements.htm
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� Fix Central Web site

http://www.ibm.com/eserver/support/fixes/fixcentral

� cimv20.dtd

ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers/cimv20.dtd

� IBMupdate.xsl

ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers/IBMupdate.xsl

� Autonomic computing

http://www.ibm.com/developerworks/autonomic/

� Installable Unit Deployment Descriptor Specification Version 1.0

http://www.w3.org/Submission/InstallableUnit-DD/

� CIM Schema: Version 2.8.2 (Final)

http://www.dmtf.org/standards/cim/cim_schema_v28

� The Open Group

http://wiki.opengroup.org/

� OASIS

http://www.oasis-open.org/

How to get IBM Redbooks
You can search for, view, or download Redbooks, Redpapers, Hints and Tips, 
draft publications and Additional materials, as well as order hardcopy Redbooks 
or CD-ROMs, at this Web site: 

ibm.com/redbooks

Help from IBM
IBM Support and downloads

ibm.com/support

IBM Global Services

ibm.com/services
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